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ACRONYMS AND ABBREVIATIONS 

BEP  Best Efficiency Point 

BoQ  Bill of Quantities 

BPT  Break-Pressure Tank 

C   Coefficient (Pipe Roughness) 

CAPEX  Capital expenditure 

DDA  Demand-driven analysis  

DEM  Digital Elevation Model 

EPA  U.S Environmental Protection Agency 

EPADEM (Risk Evaluator software) 

EPANET  (Environmental Protection Agency Network Analysis Tool) 

GI  Galvanized Iron 

GIS  Geographic Information System 

GTH  Geneva Technical Hub 

HDPE  High-Density Polyethylene 

ID  Inner Diameter 

INP  Input File (used in EPANET) 

J  Unit headloss 

KML  Keyhole Markup Language (used in Google Earth) 

KMZ  Keyhole Markup Zipped (used in Google Earth) 

LPS  Liters per Second 

lpd  Liters per Day 

mca  Meters of Water Column 

OPEX  Operational expenditure 

PDA  Pressure-dependent analysis  

PN10  Pressure Nominal 10 bar 

PE100  Polyethylene 100 (a type of high-density polyethylene) 

PVC  Polyvinyl Chloride 

QGIS  Quantum Geographic Information System 

WDS  Water Distribution System 

WMS  WASH Monitoring System 

WASH  Water, Sanitation, and Hygiene 

UNHCR  United Nations High Commissioner for Refugees 

UTM  Universal Transverse Mercator, a global map projection system 

 

GTH  The Geneva Technical Hub. 

The Geneva Technical Hub (GTH) has been established to improve the lives of refugees, 

internally displaced persons and their host communities by enhancing the quality of technical 

programming in disaster risk reduction, energy, environment, shelter/housing, settlement 

planning, water, sanitation and hygiene.  
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1. INTRODUCTION 

ABOUT THIS MANUAL 

This manual presents a simplified nine-step process for designing piped water supply in newly 

established refugee settings, while also offering valuable guidance for improving protracted 

situations. It is intended to help UNHCR staff and partners uphold the human right to water. It 

includes practical examples, essential calculations, ready-to-use templates, and how-to videos 

for easy application. 

The focus is on speed, simplicity, and low operational burden—keeping pace with rapidly 

evolving situations, phasing out costly water trucking as early as possible, and ensuring a clear 

action plan for donors. A streamlined approach from the start lays the groundwork for 

sustainability, avoiding the long-term costs of decisions made under urgent conditions. 

The manual promotes climate resilience by designing robust systems that withstand climate 

risks and aims to empower local capacity and talent in planning water distribution systems 

(WDS) effectively. 

 

Companion Material 

You can find videos supporting the content of this manual in the following YouTube playlist: 

https://www.youtube.com/playlist?list=PLn4YJsW5gPP13BxAFXw1C82TKPZOQqsG0 

There are also ready-to-use templates available to streamline, simplify, and standardize the 

process. Download EpaRef.zip, zip file containing all the book resources, here: 

https://www.arnalich.com/dwnl/EpaRef.zip 

 

Other Resources 

For additional hands-on guidance and exercises on using EPANET for hydraulic modeling, you 

can download the books below here: https://arnalich.com/dwnl/EPANETbooks.zip 

• Arnalich, S. EPANET and Development. How to calculate water networks by computer. 

• Arnalich, S. EPANET and Development. A progressive 44 exercise workbook. 

 

SIMPLIFICATIONS FOR REFUGEE CAMPS  

Unlike other systems—such as those in comparably sized towns—refugee camps: 

• Have simple distribution systems, usually consisting of public water points. House 

connections are rare. 

https://www.youtube.com/playlist?list=PLn4YJsW5gPP13BxAFXw1C82TKPZOQqsG0
https://www.arnalich.com/dwnl/EpaRef.zip
https://www.arnalich.com/dwnl/EpaRef.zip
https://arnalich.com/dwnl/epanetbooks.zip
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• The peak flow is easily determined: all taps are likely to be open simultaneously. There 

is no need to consider how demand changes throughout the day, week, or seasons. 

 

• Usually have a defined capacity limit (e.g., 50,000 refugees) within a fixed area, 

eliminating the need to project future populations or plan for expansions. 

SPECIFIC CHALLENGES 

The main challenge in refugee camps is ensuring equitable access to water. Unlike other 

systems, where users can take as much water as they need, refugee camps have a strict daily 

allowance—typically between 15 and 20 liters per person per day (lpd). If not carefully designed, 

water distribution can become a zero-sum game where some benefit at the expense of others. 

Those closer to the tanks and in lower areas often receive the lion's share of water. However, 

with thoughtful design, access can be made fair for all. Later, we will see how pressure 

management can help achieve this equity. 

At the start, these settlements face rapidly changing conditions, often without the benefit of 

exhaustive data gathering, planning, or design. Most camps begin with costly water trucking 

operations, creating strong economic pressure to transition to more economically sustainable 

systems. As a result, refugee camp water systems often inherit costly legacy problems from 

those initial rapid response decisions. 

ANATOMY OF A TYPICAL SYSTEM 

A typical piped system starts at the water source, most commonly one or several boreholes, as 

they generally provide better water quality compared to surface water sources. From the 

source, one or several pumping mains carry the water to one or several tanks, which provide 

the necessary storage to buffer the differences between water production and distribution. 

These tanks feed into a distribution network that supplies water collection points, where the 

user mainly interacts with the system. 

 

Figure 1. Anatomy of a typical water scheme. 
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EVOLUTION OF A REFUGEE CAMP’S WATER DISTRIBUTION SYSTEM 

The piped WDS usually goes through three distinct phases: 

 

1. Emergency Phase (0-6 months) – Water Trucking to Water Points 

Water points are supplied by water trucks while the pipes are procured and installed. These 

water points usually consist of one or several plastic tanks holding a few cubic meters and one 

or more six-tap distribution ramps or larger prefabricated tanks with small serving a few 

distribution ramps. In this phase, it is critical to ensure that there are enough taps, with a 

maximum of 250 people per tap, and that the area is adequately covered, with a maximum 

walking distance of 500 meters. To start on the right foot, we need to obtain the site plan, 

coordinate with site planners, and secure the necessary land and access. 

 

 

2. Transition Phase (6-24 months) – Initial Distribution Network.  

An initial piped distribution system and pumping mains are built to reduce or eliminate water 

trucking. Already at this point, it is important to consider the post-emergency network to 

Figure 2. Water point coverage in the isolated water point phase for Dougi refugee camp, Chad. 500 m buffer circles 
have been laid on top of the site plan. Source: S. Arnalich. 
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ensure the pipes are fully reused in later phases. While tanks and taps can easily be adapted and 

upgraded, buried items like pipes cannot. The post-emergency network should be an expansion, 

not a substitution, of the emergency network. Decommissioning and redoing parts later is 

wasteful, as it squanders economic resources and burdens the staff unnecessarily. 

 

 

Figure 3. Dougi camp's planned temporary network (in red) is overlaid on the site plan for scale and context. Two 
distribution networks connect the existing water points. Source: S. Arnalich. 

 

3. Post-Emergency Phase (2-20 years) – Definitive Network.  

In this phase, the service level is increased to a minimum of 20 lpd, with a maximum of 100 

people per tap and a maximum walking distance of 200 m to the nearest tap. The network needs 

to expand to accommodate the numerous new water points required to achieve this service 

level. 
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Figure 4. Planned post-emergency network for Dougi, with the newer pipes (in blue) adding to the existing emergency 
network (in red). Source: S. Arnalich. 

 

The following diagram summarizes the phases with the key indicators and targets: 

 

 

                     Figure 5. The typical evolution of a piped water system in a refugee camp. Source: S. Arnalich. 
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NINE STEPS TO RAPID DESIGN 

The proposed design sequence is broken down into the following nine steps: 

1. Gathering high-level information. 

2. Defining the core specifications. 

3. Sizing pumps and pumping mains. 

4. Sizing and siting water tanks. 

5. Preparing a backdrop. 

6. Drawing the network. 

7. Sizing the network. 

8. Validating the results 

9. Assembling the design dossier 

Each of these steps is described in a chapter in the second part of the manual. 

 

 

Figure 6. Nine steps to delivering a WDS rapid design. 
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RAPID WATER SUPPLY PLANNING  

Refugee settings require speed and adaptability to rapidly evolving situations. 

Refugee settings can change very quickly, notably at the beginning of a crisis or when significant 

new influxes occur. Resources are stretched, staff are stretched, and clarity is stretched. 

However, an early response and a full plan are essential to an efficient response. 

Refugee water distribution systems are simple and involve small investments. They are also 

constantly evolving. While orthodox water design practice typically includes a topographic 

survey and a detailed design file, there is an important opportunity cost to taking too long and 

burdening operations in the initial stages. The design files that come out are hopelessly 

outpaced by the rapidly evolving situation and result in rigidity, low resource efficiency, 

duplication of efforts, and unnecessary legacy operational costs for many years to come. The 

cost and the risk come from delaying too much the response. 

Imagine, by contrast, if a quick, phased design proposal could be done in a few days, with just 

the absolutely minimal information, using ready-made templates and remotely if necessary. 

Imagine a design plan that integrates with the site plan and site realities from the beginning, 

securing key locations such as reservoir sites. A design plan that is ready for funding 

opportunities as they come. A design plan that creates clarity and makes actor coordination 

easy. 

BARRIERS TO TIMELY DESIGN 

Traditionally, there are three main barriers to overcome for a timely design: 

1. The need for a topographic survey as a basis for the hydraulic design. 

2. The level of detail in conventional design files, which are highly information-intensive 

both in and out. 

3. The specialized skills hydraulic design required, notably when there is no in-house 

capacity and it needs to be tendered. 

 

Alternative to Topographic Surveys 

Conventional WDS designs require elevation data with centimeter-level precision. This rules out 

the use of digital elevation models (DEM), which all have error margins of several meters. 

Topographic surveys are expensive and time-consuming to execute. They also require 

procurement and contracting, adding further delays and burdening already stretched field staff. 

While precise topographic surveys make sense for more complex, high-investment systems, 

they’re not well-suited for refugee settings, especially during a crisis. The real risk isn’t in the 

system itself—WDS in refugee camps are relatively small investments. The risk and costs lie 

elsewhere: in diverting focus from other critical activities, the long-term costs of hastily 

assembled systems, and the prolonged use of inefficient, expensive, and high-carbon water 
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trucking. Delays only increase human suffering, missed funding opportunities, and overall costs. 

Insisting on a detailed survey is missing the forest for the trees. 

 

Shifting to Agile Design 

Conventional design files are highly detailed, following a waterfall approach where everything is 

defined upfront, and changes later become costly. This process is painfully slow for a refugee 

camp. A more agile approach is needed. Instead of overloading the design, review, and approval 

process with every detail—like trench specifics or the exact specifications of fittings for each 

valve box—we focus on the essentials and adapting to changes. 

Typically, a concise 25-page report, including images and annexes, along with the native files, is 

sufficient to outline the emergency, temporary, and post-emergency WDS. This approach 

enables immediate action to organize responses, secure funding, and ensure alignment among 

stakeholders. Ready-made templates (artifacts) simplify the process by focusing on what’s 

necessary and ensuring consistency. 

 

Hydraulic Designing Skills 

Despite refugee WDS usually being simple, this is the hardest of the three issues to solve. Most 

humanitarian actors lack qualified design staff or a WASH department capable of carrying out 

designs. If the design is contracted out, several months may pass before receiving anything, and 

many designs are technically lacking. Meanwhile, water trucking costs escalate quickly. 

The most effective way to address this issue is through capacity building—hence this manual 

and its companion videos. When evaluating contractor work, just two hours of training can 

uncover most problematic designs. Around 30 hours of training should be enough to significantly 

improve the quality of 80–90% of designs.  
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2. HYDRAULICS REFRESHER 

Let’s start with some basic principles and go into more detail after. 

2.1 SIX BASIC HYDRAULIC PRINCIPLES 

1. When water isn’t flowing in a pipe, the pressure is simply the difference in height 

between the tap at the bottom and the surface of the water where it enters the pipe at 

the top. The pipe’s route on the way down does not affect this difference. 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. The pressure can be measured in meters of water column. Ten meters are equivalent to 

1 bar or 1 kg/cm². 

3. When water flows through a pipe, some energy is lost due to friction against the pipe 

walls. 

4. Loss of pressure due to this friction, called friction losses, can be expressed in meters 

per kilometer of pipeline (m/km). 

5. The smaller the pipe diameter, the more pressure is lost due to frictional losses. Larger 

pipes lose less energy. 

 

A system will work if the pressure at any point along the way remains at least 7-10 meters 

while meeting the desired flows. 

Figure 7. When water is not flowing, the pipe’s routing does not affect pressure. Source: S. Arnalich 
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2.2 HYDRAULICS REFRESHER 

Water system design relies on the exchange of three kinds of energy to achieve the desired 

outcome with minimal losses.  

 

Simplifying Bernoulli with a Hippo Pool 

The three types of energy are potential (due to elevation), pressure (from the weight of the 

water column above a point), and kinetic (resulting from velocity). These correspond to the 

three terms in the famous Bernoulli equation: 

 

 

                Figure 8. Elevation, pressure, and velocity components at a point in a hippo pool. Source: S. Arnalich 

  

The equation states that energy (H) remains constant along a streamline for an ideal fluid like 

water. Any increase or decrease in one component comes at the expense of the others. 

Two useful occurrences help simplify the equation into a more convenient form. 

First, the units of each term cancel out, leaving only meters. However, these meters represent 

energy rather than distance, so we refer to them as meters of water column (mca) to distinguish 

them. 
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The second is that the velocity in water supply systems is usually low—2 m/s at most—so the 

velocity term is negligible and can be ignored. We are left with only two terms, which we will 

call elevation and depth (pressure), as both can be measured in meters. The equation simplifies 

to: 

     Constant Energy   = Elevation + Depth 

 

Returning to our hippo pool, all points in the pool share the same energy level—100 mca. For 

example, see how points P1, P2, and P3 in the image below have the same value but differ in 

the varying contribution of elevation and depth:  

 

 

 

Figure 9. All points in the pool share 100 mca energy, each with a particular combination of elevation and depth 
(pressure). Source: S. Arnalich 

 

Notice that pressure is really just depth. A point 10 meters below the surface will have a 

pressure of 10 mca. 

10 mca = 1 bar = 1 kg/cm² 

 

What would happen if we drained the water from the pool and installed a pipe following its 

profile? 

Nothing! Water molecules might not stack directly on top of each other anymore, but the same 

pressure is still transmitted regardless of the container's shape. It spreads in all directions finding 

a way. Pressure only depends on the elevation difference between the surface and the point of 

measurement, as we saw in Figure 3 at the start of the chapter.  
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Figure 10. When the pool is drained, a pipe following its profile maintains the same energy levels at every point as the 
pool once did. Source: S. Arnalich 

 

If we plot the energy levels for each point along the pipe, we get a line called the hydraulic 

gradient line (HGL). The HGL coincides with the original surface water level of the pool before it 

was drained. Because all points have the same energy, the line remains horizontal. When we 

observe the free surface of water, we are actually seeing the HGL. In pressurized pipes, the HGL 

is above the pipe. The distance between the HGL and the physical pipe is the pressure. 

 

 

So far, the water has been still. But what changes when it starts flowing through the pipe? 

As water flows, the molecules rub against each other and the pipe walls, losing some energy as 

heat—just like when you rub your hands together to warm them up. Since water loses energy 

as it flows downstream, the HGL is no longer horizontal; it begins to slope. This slope is called 

the unit headloss J (m/km), which indicates how many meters of pressure are lost per kilometer 

traveled. 
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Figure 11. Unit headloss as the slope of the HGL. It is the rate at which energy is lost as heat due to friction. Source: S. 
Arnalich 

 

The more energy that is lost, the less efficient the system becomes. When the HGL touches the 

ground, there is no more pressure. For a given flow, small pipes have steep slopes (e.g., 20 

m/km), while larger pipes have gentler slopes (e.g., 3 m/km). As you’ll see in the pipe sizing step, 

we aim for around 3 m/km for pumping mains and 5 m/km for other mains. 

Unit headloss is one of the most useful concepts in hydraulic design—make sure you understand 

it well! 

You can watch this explanation in the following video: 

https://www.youtube.com/watch?v=OXPdxd9RwGI&t=6s  

 

The Glider Analogy 

Another way to visualize this concept is by imagining water as a glider plane following a flight 

path (HGL). Pressure is like altitude—the higher it is, the more the glider cam travel. The altitude 

lost per kilometer represents unit headloss. 

Efficient gliders (good pipes) follow gentle slopes, losing less altitude (pressure), while inefficient 

ones descend steeply. If your glider touches the ground, it has lost all its altitude (pressure) and 

can no longer fly. And if the terrain rises higher than your glider’s altitude, you’ll need a motor 

(a pump) to overcome the terrain’s elevation. 

https://www.youtube.com/watch?v=OXPdxd9RwGI&t=6s
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3 DESIGN BASIS 

In this chapter, we cover the basis of the design. We will start with an overview of the design 

process to bring everything together. 

3.1 DESIGN OVERVIEW 

The design requires two main decisions: 

• Design population. What is the target population? 

• Allowance. How much water per person per day? 

For refugee camps, the design population corresponds to the maximum camp capacity 

envisioned, and the minimum allocation is as defined in the standards presented later in this 

chapter. For host communities, additional considerations include population forecasts, agreed 

per capita allowances, and the planned service life of the system. 

 

Design Steps 

1. Determine the present-day population. Populations fluctuate over time, and a system 

must account for these changes. If the current population is used as the design basis, it 

may become outdated before it is built. However, knowing the present-day population 

is important for phasing construction to match demand and available funds, or for sizing 

items with shorter lifespans, such as pumps. 

 

2. Decide the design population. If the camp's maximum occupancy is 50,000, that 

becomes the design population. The current population may be much lower, but having 

a master plan from the start is essential. Construction can be phased, and funding 

spread over time. Without a plan, expanding buried water systems becomes costly and 

difficult. Unplanned growth leads to disorganized layouts, making operation and 

maintenance challenging and expensive. 

 

3. Establish the design flow (peak flow) by selecting a design approach. An all-taps-open 

method works well for refugee camps, whereas host communities may require a time-

varying approach. 

 

4. Build a model of the water system using specialized software. Spreadsheets and hand-

made calculations impose limitations that are hard to justify today, given the 

accessibility of computers and the gentle learning curve of EPANET. 

 

5. Verify the minimum pressure. If the pressure remains above 7–10 m system-wide, the 

model is ready for optimization and fine-tuning. 
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6. Check for equity of access. All nodes in the system should have similar pressure values. 

The greater the difference between node pressures, the more flow imbalances will 

occur, favoring some users while disadvantaging others. Practically, pressure values 

should stay above 7 meters, and differences greater than 10 meters should be 

addressed by adding pressure zones. 
 

7. Verify the solution against other parameters such as velocity and free chlorine levels. 
 

8. Repeat steps 4–6 to develop multiple viable solutions. 
 

9. Benchmark and evaluate alternatives on cost. Sticking to the first model that comes to 

mind is wasteful. Even seasoned designers come up with significantly better and 

cheaper designs if they spend just a little time exploring alternatives. The more complex 

the system, the more there is to be gained from this process. 
 

10. Reality check. Is it affordable? Is it user-friendly? Land use? Objections? 

 

 

 

Figure 12.  Flowchart of the design steps. 
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3.2 STANDARDS 

This manual follows these humanitarian standards and guidance documents, which summarize 

humanitarian practice consensus and UNHCR guidance: 

• UNHCR WASH Manual 6th ed. Practical guidance for refugee settings:   

https://emergency.unhcr.org/sites/default/files/UNHCR WASH Manual.pdf 

 

• Sphere Standards. The Sphere Handbook 2018. 

https://spherestandards.org/handbook-2018/ 

Make sure to follow national standards for water supply, quality, sanitation, and environmental 

monitoring. If national standards exist, they should take precedence over UNHCR standards 

unless otherwise agreed. 

3.3 INDICATORS AND TARGETS 

UNHCR, ), in collaboration with partners, tracks key WASH indicators systematically through the 

UNHCR WASH Monitoring System (WMS). These indicators generally align with Sphere 

Standards but take into account the protracted nature of forced displacement. A full list is 

available here: 

https://emergency.unhcr.org/emergency-assistance/water-sanitation-and-hygiene/wash-

emergencies#3 

Since these standards should be adapted to reflect the cultural habits and preferences of 

displaced populations, as well as specific climatic conditions, public health concerns, and 

national standards in the host country, you should verify what the sector has collectively agreed 

upon. 

The following three are the key indicators for piped water system design: 

• Allowance: Average volume of potable water available per person. 

• Distance: Maximum distance from a household to a potable water collection point. 

• Users per tap: Number of people with access to a usable water tap. 

The following table summarizes the minimum target values for these indicators: 

https://emergency.unhcr.org/sites/default/files/UNHCR%20WASH%20Manual.pdf
https://spherestandards.org/handbook-2018/
https://emergency.unhcr.org/emergency-assistance/water-sanitation-and-hygiene/wash-emergencies#3
https://emergency.unhcr.org/emergency-assistance/water-sanitation-and-hygiene/wash-emergencies#3
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  Figure 13. Source: UNHCR WASH Indicators and Targets – February 2019. 

 

Other essential indicators, such as those defining quality requirements, are generally influenced 

more by the construction and operation of the infrastructure than by the hydraulic design.  

For institutions, the standards are: 

• Schools: 3 liters per pupil per day. 

• Health facilities: 10 liters per outpatient and 50 liters per inpatient.  

There are other important users, such as maternities, security, or administrative buildings, 

whose consumption is very small and can be lumped together with the previous as institutional 

flow. 

3.4 DESIGN POPULATION 

The design population is the settlement or camp’s maximum capacity. Future population 

growth beyond this limit is not considered. 

This limit mainly affects pipe sizing, as different assets have varying life spans and levels of 

upgrade difficulty. While adding an extra tank may be straightforward, upgrading buried pipes 

is far more complex and costly. Other components—such as storage capacity, wells, pumps, 

reservoirs, and tap stands—can be expanded more easily over time if budgets allow. 

3.5 DESIGN PEAK FLOW APPROACHES 

Water systems must be designed for peak flows, as average flows are disproportionately small 

in comparison. To estimate the likely peak flow for a given population, three basic approaches 

can be used: 
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All-taps-open 

This is the simplest approach, commonly used in refugee camps and host communities with 

public tap stands. It assumes all taps are open simultaneously. For example, if 100 taps discharge 

at 0.2 L/s each, the peak flow would be 20 L/s. 

 

Simultaneity 

Simultaneity assumes that not all users will be using the system at the same time. Based on the 

number of connections, it assigns a simultaneity coefficient that multiplies the average flow. In 

plain language, it means something like: “For fifty connections, the peak flow is 8.1 times the 

average flow.” 

It has one important drawback: since different connection numbers have different coefficients, 

this method violates the law of mass conservation. For example, a water main carrying 20 l/s 

might split into two pipes carrying 12 l/s each. Obviously, this doesn’t add up, so computer 

software cannot be used to model it accurately. For this reason, the approach is now mostly 

limited to the internal plumbing of buildings. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Time-varying Demand 

Time-varying demand also assumes that not all taps are open simultaneously. By analyzing water 

use hour by hour, day by day, and month by month, we can determine the daily, weekly, and 

monthly peak coefficients, which together define the peak flow. For instance, if the highest daily 

flow is twice the average, the weekly flow is 1.2 times, and the monthly flow is 1.5 times, then 

the global peak coefficient is:  2 × 1.2 × 1.5 = 3.6 times the average flow. 

For most systems, this coefficient typically falls between 3.5 and 4.5. 

Figure 14. Simultaneity coefficients for different numbers of connections. Arizmendi, 1991. 
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This approach breaks down for smaller pipes because the number of users per pipe segment is 

too low. Regardless of the average flow calculated for the pipe going to Marie’s home, she will 

still need the full tap flow of 0.2 lps—not just four times the 0.0012 lps we estimated earlier. 

However, the solution to this problem is simple and allows for computer modeling: establishing 

a minimum pipe diameter, which is good practice anyway. Except for service connections 

shorter than 50–100 m, installing very small pipes is a recipe for disaster. 

This approach should be applied only where queues are not expected and where a minimum 

pipe diameter has been set. It is less common in refugee camps and, depending on the context, 

in host communities as well. Since it requires a more advanced understanding of water systems, 

this book will not cover it. For a detailed explanation, see EpaDev. 

 

Choosing a Peak Demand Approach 

It comes down to answering the following questions: 

 

 

 

 

 

 

 

 

 

 

An Important Note on Design Tap Flows 

The Sphere standards use the figure of 7.5 l/minute (0.125 l/s) per tap as an assumption for the 

250-people-per-tap indicator. It is not an indicator. Unfortunately, this figure has stuck, but it is 

clearly insufficient in most refugee settings with short distribution slots.  

At 0.125 l/s, 250 people would need at least 8 hours and 20 minutes to collect the minimum 

amount of water prescribed. Most refugee settings distribute for only 4-6 hours at most. A flow 

rate of 0.125 l/s is insufficient to meet the 15-liter-per-person-per-day indicator in most camps. 

Use a minimum design figure of at least 0.2 l/s instead, which also allows for a seamless 

transition to post-emergency standards with little, if any, added cost. A six-tap distribution ramp 

would then require 1.2 l/s, for example. 

 

Figure 15. Flow diagram to choose the appropriate design approach for a context. 
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The Importance of Enforcing a Minimum Diameter 

Small pipes are easily blocked by air and sediments and very sensitive to flow changes or 

measurement errors. Regardless of the design approach chosen, enforcing a minimum diameter 

is critical. For a refugee context, a minimum diameter of 63 mm is adequate. 

Smaller diameter pipes should be used only for service connections, and their length should be 

kept below 50 m, 100 m at most. While installing 1 km of 32 mm pipe may seem like a way to 

save money, it invariably ends up costing more in repairs and rehabilitation than was saved. 

When installing these small pipes, an important part of the cost and effort goes into burying, so 

there is little to gain and much to lose in terms of operation and maintenance, flexibility for 

future changes, and reliability. 

3.6 HYDRAULIC DESIGN CRITERIA 

 

Minimum Working Pressure:  10 m (7 m exceptionally in a few points) 

This minimum pressure at any point in the network is essential to guarantee a fair and properly 

functioning system. The technical reasons are plentiful—from avoiding bubbles and column 

separation to safeguarding against data inaccuracies, mistakes, or changing conditions. It is also 

essential for equity, as at very low pressures, small pressure variations can cause significant 

differences in tap flow: some people will get a drip while others a blast of water. 

The absolute minimum should be 7 m, except when it is geometrically impossible—for example, 

at the start of lines after a ground tank—or impractical, i.e., requiring disproportionate 

investments for a single point. Most of the network should remain above 10 m, keeping the 7 m 

absolute minimum for a few points at most. 

 

Working Pressure Range at Tap:  10-20 m 

Since we've already covered the lower end, let's now examine why adjusting the higher limit is 

important. The more pressure there is at the taps, the more water will be wasted. Higher 

pressure is inconvenient for users, and if self-closing taps are used, some groups that are not 

strong enough to open them, are excluded from access or made dependent on others for 

assistance. 

Ideally, all points in a single network should have similar pressures at the lower end of the 

bracket. Similar pressure values allow users to collect similar quantities of water. Pressure 

disparity is a driver of inequality. 

However, achieving similar low-pressure values network-wide is not always possible or easy. 

Reducing pressure in a valley often prevents water from reaching the next hill. One simple and 

cost-effective approach is to install ball valves at tap stands to adjust pressure as needed. 
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Tentative Maximum Working Pressure:   45 m 

The more pressure a system has, the more water is lost to leakage, and the higher the 

maintenance issues due to increased wear and tear on pipes and fixtures. Beyond a point, 

usually 70–80 m, pipes with a higher pressure rating need to be installed. These pipes have 

smaller inner diameters, which carry less water. 

There are situations where high pressure is inevitable due to elevation differences in a pumped 

main or when crossing a valley. In most other cases, keeping pressure below 45 m is possible. 

Pressure can be reduced using break-pressure tanks, pressure-reducing valves, or through 

friction created by small orifices. 

 

Velocity:  0-2.5 m/s  

The most important point here is that there is no minimum velocity. Sometimes, a minimum 

velocity of 0.5 m/s is cited as a standard for self-cleaning of pipes, but that recommendation 

applies to larger pipes (i.e., 400 mm). As pipe diameter increases, water can flow more quickly 

without generating much friction against the walls. But for the smaller pipes of a refugee camp, 

even that velocity can lead to very high friction losses. Enforcing this rule can result in 

unacceptable pressure losses and systems that are too expensive to run. The intermittent nature 

of the supply also facilitates self-cleaning. 

Higher velocities indicate that the pipe is too small and operating outside its efficient range. 

Additionally, they create other problems, such as cavitation in valves and erosion of valve seals, 

and they exacerbate water hammer issues. 

 

Tentative Unit Headloss for Distribution Mains:   3-7 m/km 

This range is usually the best compromise between investment costs and running costs. 

Values over 7 m/km usually indicate that the pipe diameter is too small. In pumping mains, we 

would be wasting more fuel than necessary to overcome friction. If it is a distribution main, we 

probably need to raise the tank’s elevation to avoid running out of pressure too soon. This would 

waste fuel by pumping water to an unnecessarily high location. All related equipment, such as 

pumps, generators, or solar arrays, would need to be more powerful and, hence, more 

expensive. 

Values below 3 m/km usually indicate that the pipe diameter is too big. We would be installing 

unnecessarily costly pipes with little return in terms of energy savings. One notable exception is 

for minimum-diameter pipes. 

This can be further refined for a particular context with precise economic calculations. There are 

also logical exceptions to this rule. For example, when the terrain is extremely flat or steep, 

exceeding these limits may be good practice. 
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3.7 WATER QUALITY CRITERIA 

From a microbiological point of view, water will be considered safe to drink if three conditions 

are met: 

1. At least 0.2 ppm (or mg/l) of free chlorine. 

2. A minimum of 30 minutes of contact time to act. 

3. A turbidity below 5 NTU. 

These parameters are mostly outside the control of hydraulic design and will not be considered 

further.  

3.8 PIPE MATERIAL AND SIZE 

Besides the pipe length, there are two main pipe characteristics relevant to the design: 

 

Pipe Diameter 

Design consists mainly of pipe sizing, which means selecting appropriate diameters. Pipes are 

manufactured and named according to their standard nominal diameters (ND), e.g., a 110 mm 

pipe. For plastic pipes, this corresponds to the outside diameter (OD). Subtracting the wall 

thickness—which varies based on material and pressure rating—gives the inner diameter (ID), 

e.g., 97 mm. 

Two important warnings: 

Always use internal diameters in all calculations. Using nominal diameters 

for calculations can lead to significant errors, which can often determine 

whether a system functions properly or not.  

 

DO NOT install pipes below PN10, regardless of the system's pressure. 

Pipes must withstand forces beyond just pressure, including soil loads, 

vehicle weight, and even large animals like giraffes. Installing sanitation or 

agricultural-grade PN6 or PN8 pipes is a serious mistake. 

The following table summarizes the common internal diameters of plastic pipes: 

 

Diameters below 63 mm have been greyed out in the table because water systems should have 

a minimum diameter.  

Nom. diameter 25 32 40 50 63 75 90 110 125 140 160 180 200 250 

ID HDPE PN10 20 26 35 44 55 66 79 97 110.1 123 141 159 176 220 

ID HDPE PN16 20 26 32 41 51 61 73 90.1 102 114 131 147 163 204 

ID PVC PN10 20 26 32 41 51 61 73 90.1 102 114 131 147 163 204 
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In many contexts, pipes above 110 or 125 mm can be challenging to procure and install. HDPE 

pipes below 125 mm typically come in coils and can be joined using compression fittings or an 

affordable HDPE welding machine. However, this diameter can efficiently serve between 10,000 

to 15,000 people, whereas many settlements are larger. In such cases, multiple pipes may need 

to be installed in parallel, or networks subdivided into smaller zones, each served by a single 

pipe. 

 

Pipe Material 

For hydraulic calculations, the only effect is that different materials produce different frictions. 

This is measured with a roughness coefficient (C) that depends on the material the pipe is made 

from, and the age and condition of the pipe. Depending on the hydraulic formula used to 

determine friction, these coefficients take different values. For the Hazen-Williams equation: 

• Plastic pipes. HDPE and PVC have a roughness coefficient of 140 and retain this value 

throughout their lifespan. 

 

• Galvanized iron (GI) pipes have a coefficient of 120 which decreases with age and pipe 

condition. 

Other materials are uncommon in refugee settings. If needed, their coefficients can be easily 

looked up online. 
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4 GETTING STARTED WITH EPANET 

4.1 INTRODUCING EPANET 

EPANET is a free, open-source water network calculation program created by the U.S. 

Environmental Protection Agency (EPA). It has a user-friendly interface and is easy to operate.  

 

 

Besides being free, this is one of the main advantages of EPANET over other, more complex 

hydraulic design software. It is quick and simple to learn. You can grasp the basics in an 

afternoon and become proficient in about 30 hours. 

 

Downloads 

Download EPANET and its user manual from the official EPA website: 

https://www.epa.gov/water-research/EPANET. 

     Figure 16. EPANET screenshot featuring the model of Lugufu refugee camp, Tanzania. 

https://www.epa.gov/water-research/epanet
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Additional Resources 

As mentioned in Chapter 1, alongside the companion videos and the EPANET official user 

manual, these two books are particularly relevant for using EPANET in development and 

humanitarian settings: 

• Arnalich, S. EPANET and Development: How to Calculate Water Networks by Computer. 

• Arnalich, S. EPANET and Development: A Progressive 44-Exercise Workbook 

The first, which we’ll refer to as EpaDev from now on, complements this manual and extends 

the knowledge to non-refugee settings. Download them here if you haven't already: 

https://arnalich.com/dwnl/EPANETbooks.zip 

 

Languages 

EPANET and the user manual are available in Spanish, Portuguese, French, and Russian. Since 

the links change frequently, it's best to search for them online. 

Most translations are based on the older 2.00.12 version. These may or may not use a comma 

as the decimal separator. You can check by adding an object and attempting to input a property, 

such as a pipe length, using a comma. Normally, the software will only accept points. If commas 

are required, be aware that this will pose significant limitations, for example, when assigning 

elevations in bulk from a DEM. 

 

Versions and Compatibility 

The older 2.00.12 version is fully capable of handling the design work in this book. If you think 

language will be a barrier, then this is the better choice. 

Version 2.2 includes improvements and added functionalities. The most relevant new feature 

for our use case is the ability to run pressure-dependent analysis (PDA) to assess the equity of 

distribution. Unlike traditional demand-driven analysis (DDA), where demands remain fixed 

regardless of pressure, PDA allows demands to vary based on the pressure at each node. This is 

more realistic for scenarios where pressure significantly impacts water delivery, such as in 

refugee camps. Assessing and improving distribution equity is crucial. If there is no language 

barrier, I recommend choosing this version. 

EPANET files are largely compatible across versions, but caution is needed when using features 

that may not exist in older versions.  

 

Limitations 

These are the main limitations in our context: 

• Inability to model water hammer: This refers to rapid, transient changes in flow, such 

as those caused by sudden valve closures, the presence of air in pipes, or the abrupt 

https://arnalich.com/dwnl/EPANETbooks.zip
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starting and stopping of pumps. Given the small size of components in typical 

humanitarian projects, transient effects can usually be safely ignored. However, that is 

not the case when working with larger pumps and pipes, especially metallic ones. Allievi 

(www.allievi.net) is a free and powerful program for evaluating water hammer effects 

and the protective equipment required. 
 

• Limited GIS integration: While EPANET can import data from GIS, it is not natively 

designed for extensive GIS integration. 
 

• Absence of financial analysis tools: EPANET does not provide built-in tools for economic 

analysis, such as cost estimation for infrastructure investments or lifecycle costing. 
 

• Lack of some basic interface features: The absence of an undo button and the inability 

to track changes are the most significant omissions. 

These challenges can typically be addressed by making minor adjustments to the workflow and 

utilizing add-ons. 

4.2 AVOIDING TIME WASTING WITH EPANET 

As you begin using EPANET, be mindful of the following common time-wasting pitfalls. 

1. Drawing models too precisely. PANET handles drawings as basic sketches, so avoid 

wasting time making lines perfectly parallel or angled. Even when using a backdrop 

image with Auto-length enabled, EPANET calculates distances as if the model were flat. 

For example, if the distances and properties remain the same, the two models shown 

below will produce identical results: 

 

 

 

 

 

2. Forcing strict label sequences: EPANET assigns consecutive numerical labels to 

elements as they are drawn (e.g., Pipe 10, Tank 3). As you add, delete, or modify 

elements, the numbering will become disorganized. It is better to wait until the end to 

adjust labels—or not do it at all.  
 

3. Overcomplicating models: Models are representations, not exact replicas of reality. The 

simpler the model, the better. Including unnecessary details will slow you down when 

making modifications or improvements to the base model. Fewer objects mean fewer 

items to edit when sizing and less overcrowding when reading results on the screen. For 

beginners, overcomplicated models can be overwhelming, leading them to waste time 

http://www.allievi.net/
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trying to model elements that don’t even need to be included. Remember, your model 

isn't a set of building plans—keep it streamlined. 
 

4. Destroying your base model. Once you have drawn all the items and assigned their 

properties, save a copy of the model so you can return to the original if needed. 
 

5. Not saving versions of the model frequently and after every milestone. Remember 

there is no undo button! 
 

6. Not tracking the changes when working on an existing network. If you're working with 

a new network, the task is straightforward—what's on the screen is what needs to be 

built. However, when dealing with an existing system, you'll need to manually document 

any changes. EPANET lacks a change-tracking feature to identify modifications made to 

the model. 

4.3 SETTING DEFAULTS 

Avoiding Unit Mistakes 

When working with EPANET, follow this procedure as a pilot checklist to avoid catastrophic 

mistakes: 

1. Go to Project > Defaults: 

 

 

 

 

 

2. In the dialogue box that opens: 

2.1 Go to the Hydraulics tab. 
 

2.2 Under Flow Units select LPS. This sets the units you 

will work with as follows: 
 

• Flow Units: liters per second 

• Pressure: meters of water column 

• Diameter: millimeters 

• Length: meters 

• Height: meters 

• Dimensions: meters 

 
2.3 Make sure Headloss Formula is set to H-W (Hazen-Williams). With this formula and 

plastic pipes, the pipe roughness will be 140. 
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2.4 Check Save as default for all new projects. Do not close the box yet. 

 

Avoiding Data Input Errors 

Invariably, you will make data input mistakes. The key is to uncover them easily, set the default 

values and then query for those values.  

1. Switch to the Properties tab of the Defaults dialogue box. If you closed it, open it again 

(Project > Defaults). 

 

2. Set the pipe length to 9999. Any pipe drawn with the 

automatic length mode inadvertently off or without 

an assigned length will take this very unlikely value. 

 

3. Set the pipe diameter to 999. Avoid using any 

commercial diameter as a default to ensure all pipes 

have their correct diameter and do not inherit a 

default value that may ruin calculations. 

 

4. Enter the Pipe Roughness value of the pipe material 

you will be using most commonly. 

 

5. Leave the rest of the values as they are. It is very unlikely, for example, that nodes will 

have an elevation of 0.  
 

Once your network is complete, use the Query tool to search for the default control values. For 

example, “Find Links with … Length… Equal to … 9999” will help you uncover a data input 

mistake, as shown in the image below: 
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4.4 FINDING YOUR WAY IN EPANET 

The Browser  

EPANET has a simple user interface, and it is straightforward to learn. The menu 

layout and the icon bars are like most programs, so we are not going to cover them 

here. 

What is quite unique about EPANET is the Browser. This rather unassuming box is 

where most of the action occurs. If you are a beginner, spend some time exploring 

how it works and how it populates as you add data. 

 

EPANET’s Objects 

These are the six objects used in EPANET to draw the network: 

 

 

 

 Junctions (Or nodes). A junction is a point at a certain height where water exits or 

enters the network. This happens when it is assigned a demand. If a negative demand 

is assigned, it becomes an inlet instead. As a basic building block, it is needed to branch 

off pipes and serve as a connection hub. 

 Reservoirs act as drains or water sources. Their volume stays constant regardless of 

water added or taken due to their immense size compared to the system. That is the 

key difference from a tank. Examples include rivers, lakes, and aquifers. 

 Tanks store water with a limited capacity. Their water level rises or falls as they fill 

or empty. 

 Pipes (or links) carry water between parts of the system. EPANET assumes pipes are 

always full. To open, close, or limit flow direction, you don’t need to add valves. These 

conditions are set in the Initial Status section of their properties.  

 Pumps can sometimes be a bit problematic in EPANET. Whenever possible, it's better 

to split systems into parts to avoid them. Pumps add energy to water. 

 Valves. These are automatic valves. While infrequent in developing contexts, we can 

use their properties to model other setups—for example, a pressure-reducing valve to 

simulate a break-pressure tank. Again, non-return and shut-off valves are already 

included as pipe properties. 

 

To understand the objects’ properties in detail, read pages 38–55 of EpaDev. 
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The Introductory Tutorial 

EPANET comes with a built-in tutorial. It is the perfect exercise to familiarize yourself quickly 

with the most commonly used features. You should complete it now to follow the rest of the 

book.  

 

Exercise 4.1. EPANET’s Built-in Tutorial  

Follow the steps of the introductory tutorial until 

you click the Run icon for the first time. 

You can launch the tutorial by going to Help > 

Tutorial. Use the arrows in the upper right corner 

to navigate through it. 

If you prefer, check video 4.1 in the YouTube 

playlist for this book.  

 

 

 

 

 

Exercise 4.2. Simple Network Design 

Design the network using all the concepts you have learned so far. 

 

 

 

 

 

 

 

 

 

For a step-by-step resolution, watch video 4.2 in this book’s YouTube playlist. 

Figure 17. EPANET's built-in tutorial. 
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4.5 MODELING STRATEGIES 

It is common for beginners to try to model everything exactly as it is. This often makes them hit 

a wall, as this is not really feasible—and most importantly, it is not a good idea. Except for the 

simplest networks, the result ends up looking like a garbled mess. 

Instead, the strategy is to build the simplest, most practical model you can get away with while 

still getting accurate results. With this in mind, let’s look at approaches that will save you time 

and produce better results with fewer headaches: 

 

Less Is More - Skeletonization 

Imagine you have a very complicated, detailed network. There are pipes doing the heavy lifting 

and pipes that are like passersby watching the work—they hardly do any work and may be there 

for other reasons: 

• To reach the end user. 

• To add redundancy. 

• Due to inefficient design. 

Now we are going to start removing pipes from our model to get a model that perform just as 

well1 but is simpler. Let’s start with the easy calls: 

1. The interior network of buildings. Design practice separates the public network from 

the private one, with the border at the water meter. By supplying enough yield and 

pressure to the water meter, we simplify the model. 

 

2. Public installations with many elements in a limited space that can be easily simplified. 

For example, in our case, a six-tap distribution ramp turns into just one node2.  

 

 

 

 

 

 

3. Removing short stretches of pipes, such as service connections. In the image below, 

almost half of the cluttered elements can be removed by eliminating the nodes 

connected with short pipes (in red) and moving their demand to the nearest node: 

                                                            

1 The more scientific way of doing this is to define criteria and set tolerances, for example, ensuring that pressure in 
the skeletonized model does not change more than 5% at any location. 
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Figure 18. Short pipe realism results in nodes piling up on each other. The changes in pressure, chlorine 
levels, or aging over these short spans will be negligible. Adding them only clutters the model. 

 

 

4. String of beads. Unless their elevation varies significantly, all nodes in a string can be 

removed and their demand moved to the end nodes (dotted arrows). For example: 

 

 

 

Figure 19. Demand along 
a string of beads can be 
shifted to the end nodes 
for a simpler, yet 
hydraulically equivalent 
model. 

 

 

 

The point is to remove non-critical elements while preserving hydraulic accuracy. Remember, 

the EPANET model is not the building plans. In-depth detail should be captured elsewhere. 

 

Cutting Corners… Tactically - Partial Model Equivalence  

This is the smaller sister of skeletonization. Instead of models yielding the same results in all 

situations, we build a model that is true if certain conditions are met. Let’s see it with the most 

useful example. 

Imagine a pumping main feeding a tank on a hill. The tank then feeds a distribution network by 

gravity. Our task is to size the distribution system:  
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No matter how hard you pump, the pressure (or velocity) in the distribution system will not be 

affected. This is because the tank is open to the atmosphere, so any excess pressure at the inlet 

cannot make it to the outlet. From a pressure point of view, and provided that the tank always 

contains water (the condition!), we can consider only the distribution part and ignore the 

pumping part. 

 

 

   Figure 20. Splitting the model into pumping and distribution mains at the tank makes each much easier to analyze. 

 

Now it is time to pay attention to the partial part of partial model equivalence. This new model 

is not equivalent to the original one in all cases. It is equivalent only for certain variables and 

under certain conditions. It is equivalent for pressure provided that there is always water in the 

tank, but it is not equivalent for water aging or chlorination, for instance. Depending on what 

we want to analyze, we can build partial simpler models. In refugee settings, for example, we 

are not usually concerned with water aging because water will be completely exhausted at least 

once a day. 

Other very useful example is the pump reservoir substitution where we get rid of pumps by 

substituting them with reservoirs with their total set to the elevation plus the pressure required 

to size complex networks without the hassle of the pumps. Once the networks are sized, they 

can be added if necessary for fine-tuning. 
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Divide and Conquer - Modular Design  

Often, EPANET models are like taking several medications. The more pills you add, the greater 

the probability of side effects. Using what we have just seen, we can break down a complex 

model into smaller, simpler, more manageable units. 

Continuing with the example below, it is often very helpful to divide it into at least four parts: 

a. The pump 

b. The pumping main 

c. The tank 

d. The distribution network 

Independent networks that feed from the same tank can be modeled independently, assuming 

there will be water in the tank, since they can’t affect each other’s hydraulic behavior. This 

breakdown of the system into smaller pieces is key to the next strategy. 

 

Choose Your battlefield  

EPANET is not the be-all and end-all. Some things are better done in other software. For 

example, you can size a tank in EPANET, but it will test your patience. Alternatively, you can go 

to a spreadsheet and have it done straight away. The same goes for sizing pumps, notably if 

accompanied by economic calculations of different scenarios (IIRR)3.  

Out of the four items we saw in the previous strategy, I mostly just use EPANET for distribution 

systems. Pumps, pumping mains and tanks should really be sized together as an economic 

exercise, and I find this is better done in a spreadsheet in most of the cases we find in a refugee 

context.  EPANET adds value when there is a minimum complexity, for instance, when there are 

several pumping mains branching off each other, pumps pumping straight to the distribution 

network or more complicated configurations. 

 

Thinking Out of the Box - Using EPANET Objects Imaginatively 

Don’t think of EPANET objects as their real-life equivalents, but rather as a catalogue of building 

blocks performing certain functions. We often use and connect EPANET objects in ways they 

would never be in real life! For example, a reservoir can be used as an overflow, or a pressure-

reducing valve set to zero is a break-pressure tank with no tank required. The “pressure-

sustaining valve” building block can be used as the top inlet to a tank (if there is a need for such 

accuracy!) since EPANET fills them from the bottom by default. 

If you can break free from real object thinking, your modeling will take a leap forward. The 

upcoming 'How to Model a…' section will illustrate this approach with objects connected in 

puzzling ways. 

                                                            

3 Incremental Internal Rate of Return.  
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Using Dummies 

Sometimes you need to connect objects in the network or establish but don’t want them to 

affect the system hydraulically. This is achieved by giving them properties that will have 

negligible effects: 

• Dummy pipes are used to connect nodes but in a way that they don’t affect pressure 

(or flow). This is achieved by giving them very short lengths and large diameters. I like 

to use 0.9 m and 9999 mm, respectively, to identify them easily. 

 

• Dummy nodes are also needed as connectors to organize the system. They usually have 

no demand and the same elevation as a nearby object. 

 

• Other. There are also dummy valves, reservoirs, etc. 

They’re useful for simplifying complex networks without changing the hydraulic results and as a 

workaround for problems. Imagine you need to model a flow control valve in the outlet of a 

tank. EPANET will throw an illegal connection error if you connect valves directly to tanks or 

reservoirs. The problem is solved by adding a dummy node and a dummy pipe: 

 

 

 

 

 

 

 

 

 

 

 

 

 

       Figure 21. Using a dummy pipe and a dummy node to solve the "illegal valve connection" error. 

 

 

Later in How to model a spring you will use dummies extensively. 
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In Summary 

Don’t get caught up in unnecessary details or excessive realism—use your imagination! 

4.6 HOW TO MODEL A… 

In this section, we will practice modeling common layouts. Please read pages 55 to 62 of EpaDev 

to understand the process for each. We will start with the free-flowing pipe that is not covered 

there. 

 

Free-Flowing Pipe 

A free-flowing pipe that is not connected to anything. Picture a hose connected to an open tap.  

To model it: 

1. Place a node at the open end of the pipe. Open its properties box and type a very large 

number in Emitter Coefficient. Again, I like to use nines. Notice how the node shape 

changes to a rhomboid: 

 

 

 

 

 

Exercise 4.3. Modeling a Free-Flowing Pipe. 

What is the flow you can expect from a 2 km, 110 mm PN10 HDPE pipe that is a gravity main 

between a spring at 800 m of elevation and a distribution tank at 734 m?  

 

 

 

 

 

You can watch video 4.3 in the playlist and find the EPANET files in the book’s download 

file, EpaRef.zip. 
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Exercise 4.4. Modeling a Break-Pressure Tank 

Model a break-pressure tank between a reservoir at 220 m of elevation and a tank at 105 m. 

The length of the pipe is 1 km before and 1.5 km after the tank, and the chosen location for 

the elevation for the BPT is 160 m. Make sure that the pressure in the pipes does not exceed 

80% of the pipe rating (HDPE 140 mm PN10). 

 

 

 

 

 

 

You can watch video 4.4 in the playlist and find the EPANET files in EpaRef.zip. 

 

Exercise 4.5. Modeling a Pump 

Size a pump that pumps 5 l/s from a reservoir at 0 m to a tank at 66 m through a 2.5 km long 

110 mm PN10 PVC pipe.  

 

The geometric head is the difference in elevation:  66 m – 0 m = 66 m 

The friction head is obtained from EPANET: 10.96 m 

The velocity head is negligible: 0 m 

The total head is 66 m + 10.96 + 0m ≈ 77 m 

The duty point of the pump needed is (5 l/s ; 77 m). 

 

By setting elevations to 0 m, the pressure at the end node reflects the total friction head loss, 

calculated as 4.38 m/km × 2.5 km = 10.96 m. 

 

 

 

 

 

You can watch video 4.5 in the playlist and find the EPANET files in EpaRef.zip. 
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Exercise 4.6. Modeling a Borehole 

Model a borehole with a DWL of 30 m, a 200 m long HDPE 75 mm PN10 riser pipe, and a 2 km 

long HDPE 90 PN10 pumping main to a tank. The elevation of the borehole head is 600 m, and 

the tank is at 640 m. The duty point of the pump, a Fictitia SP18, is (3 l/s, 80 m). 

 

 

 

 

 

 

 

 

 

 

You can watch video 4.6 in the playlist and find the EPANET files in EpaRef.zip. 

 

Exercise 4.7. Modeling a Spring 

Model a spring that feeds a tank 30 meters below through a 6 km long, 110 mm HDPE PN10 

pipe. The spring flow is 6.5 l/s. Is the pipe able to deliver this flow, or does it require a change 

of diameter? 

 

 

 

 

 

 

 

 

No, the pipe needs to be at least 125 mm pipe (ID, 110 mm). 

You can watch video 4.7 in the playlist and find the EPANET files in EpaRef.zip. 
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4.7 COMMON MISUNDERSTANDINGS AND PITFALLS 

 

Reservoir vs. Tank 

Reservoirs are infinite sources of water; they don’t empty or fill. Think of an aquifer, a lake 

or a river. 

Tanks are what comes to mind with the word, containers limited in their capacity, for 

example, a 400 m3 concrete tank or a 5 m3 plastic polytank. 

 

Pumps Don’t Include the Pipe 

When you draw pumps, it looks like the pipe comes in the package. It is very misleading decision 

from the software. 

When you draw a pump, make sure to draw the 

required pipes as well to account for the 

friction losses in the pipe. Otherwise, this 

innocent misunderstanding will throw off all 

your calculations! Lengthy pumping mains are 

particularly sensitive. 

 

Valves Don’t Include the Pipe Either 

The same goes for valves: 

 

 

 

 

Shut-Off and Non-Return Valves Are Not Drawn as Objects 

Instead, they are modeled by setting the Initial Status 

property of the pipe as Open, Closed or CV to open, 

close or place a non-return valve. This valve will allow 

flow in the direction the pipe was drawn. If you need to 

change it, reverse the pipe (see Negative flows later). 

The valves we draw in EPANET are the hydraulic 

automatic valves: flow control valves, pressure 

sustaining valves, pressure reducing valves, etc. 

 



47   Piped Water Supply Design for Refugee Settings    

Negative Demand Nodes Scramble Pressure Values. 

NEVER model a borehole, spring or any other fixed flow entry as a simple 

node with negative demand. While a node with a demand of -2, for example, 

does input 2 l/s in the system, it does against any resistance that it may 

encounter, even infinite, ruining all calculations and giving you a false sense 

that the system works. 

 

Negative Pipe Flows: No Practical Significance 

Positive or negative flow is just a convention to signal the direction 

of flow. If you drew the pipe in the opposite way from the flow 

direction, the flow will be negative. That is all there is to it. If that 

really bothers you for some reason, you can right-click on it and click 

Reverse. You can do this with pumps and valves too. 

 

Draw Pumps and Valves in the Direction of Flow 

This is critical for pumps, as it determines which way the water will go. If you imagine the pump 

icon as a cannon, the flow will be the direction of the cannonball. Valves will give trouble too as 

they are also directional. For example, a pressure-reducing valve needs to know which is the 

high-pressure and the low-pressure side. 

You learned in the previous paragraph how to reverse elements. 
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PART 2. Rapid Water Distribution 

System Planning for Onset Crises 
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STEP 1. GATHERING HIGH-LEVEL INFORMATION 

 

A high-level design outlines the architecture and major components of the system. It is the big-

picture design. High-level information is the minimum information required to achieve the high-

level detail. 

Here are a few key points to prioritize when gathering this foundational data: 

1. Have only the absolute minimum information. Less is more. Excess information delays 

responses, reduces clarity, and burdens operations and planners. 

 

It's easy to slip into analysis paralysis and begin stockpiling 

unnecessary, low-level information. To avoid this, enforce the 

absolute minimum requirement strictly. 

 

 

2. Centralize all key information in one place to simplify interpretation, updates, and 

communication. When information is scattered across numerous files and lengthy 

reports, it feels overwhelming for the recipients, leading to garbled communication, 

increased errors, and wasted time. The information should be summarized in a single 

document. 

 

3. Create a neat online dossier. A summary two-pager, a site plan, and a Google Earth file 

should suffice at this stage. Having the dossier online in Dropbox, Google Docs, or any 

other document-sharing service avoids having several versions circulating, and it can be 

updated on the go. Avoid dumping unrelated documents, reports, or orphaned Excel 

files into the main dossier—they only create unnecessary clutter. 

 

4. Do not wait for all the information to be complete. Send the bulk when available while 

waiting for the few missing pieces of information that may or may not ever come. 

Especially avoid delaying tank siting, as we need to secure the required land as soon as 

possible. 

 

5. Work with and provide native formats. Nothing is more frustrating than receiving a map 

as a blurry image, coordinates in a locked PDF, or printouts of EPANET files in a Word 

document. Use .GPX, .KML, .TXT, .XLSX, .NET, etc., instead. 

 

6. Work with formats that are open, widely mastered, and easy to use on common 

smartphones. While AutoCAD or shapefiles may seem very simple to you personally, 

they create unnecessary barriers in terms of licenses, skills, or the ability for some local 

staff to collect or verify information in the field. 

 

GOAL:  Collect the key information strictly required for the design quickly and systematically. 
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7. If you still feel that you must absolutely include additional files or want to file them for 

“future reference”, please place them in a separate folder labeled 'RAW IN' to keep the 

main dossier light and organized. However, this practice is not recommended. 

In summary, do not overload the planner with a blizzard of disconnected data to make sense 

of. Create a concise dossier containing only the essential information.  

THE ABSOLUTE MINIMUM INFORMATION TO GATHER 

1. Current and Maximum Camp Population Figures 

The current figure may be ballparked, as often the registration of refugees is ongoing.  Having a 

precise number is not necessary, but it should be as accurate as possible given the 

circumstances. 

The maximum camp size for the camp can be obtained from site planning. 

 

2. The Site Plan 

A site plan is the layout of the camp on a map. You can think of it as a masterplan. Liaising with 

site planners to obtain a site plan as early on as possible is essential for communication and 

securing prime locations, such as those central and elevated for water tanks. If these prime 

locations are not secured early on, the water system design will be more difficult and there will 

be legacy costs and problems for years to come. 

 

    Figure 22. Example of a site plan, Dougi refugee camp, Chad. Source: UNHCR, Chad. 



53   Piped Water Supply Design for Refugee Settings    

The site plan provides the map on which the WDS will be overlaid and integrated with the rest 

of the sources. It is essential that it includes geolocation information, in other words, to 

determine its position on the Earth's surface. 

 

Figure 23. Geolocated overlay of the site plan in Google Earth. Notice the UTM coordinate grid and the camp contour 
in purple that was provided as a Google Earth KML file to be able to geolocate it. Source: S. Arnalich 

 

This can be done in several ways, for example: 

• Using the North arrow and the coordinates of the lower left and upper right corners.  
• Using coordinate system gridlines of UTM or Geographic coordinates if the site plan 

includes them. 

• Obtaining a Google Earth file with easily identifiable locations or the camp's contour. 

The process to prepare the image above will be seen later in the book. 

FORMAT: The preferred format is a PDF that can easily be converted into a high-resolution 

image. Although having an AutoCAD or .dwg file may be useful for other purposes, it is best 

avoided at this stage, as mentioned earlier, unless you have the skills and license. 

 

3. Existing Settlement Areas and Potential Expansion Zones 

Usually not all the areas in the site plan are occupied at once. This is important to concentrate 

the emergency efforts on the people already there. 

If there is a sudden influx of refugees and the camp would need to be extended beyond the site 

plan or there is an organic settlement with time, what would be the likely areas to be settled?  

FORMAT: Image or a Google Earth KML/KMZ file. 
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4. Description of the Water Sources 

The key parameters are the source type, yield and its elevation. 

If it is surface water, the coordinates of the source are enough. If it is groundwater, coordinates, 

yield and dynamic water level of each well will be necessary.  

 

DO NOT use the pump’s installation depth4 as the reference for the pumping 

head, as it can lead to important mistakes. The pumping head is calculated from 

the surface of the water in the well when pumped (dynamic water level) to the 

maximum surface in the tank (overflow). 

 

For both surface and groundwater, we need the existing or planned source of energy. If the 

wells are fully solarized, then there is a restriction on the number of hours we can pump during 

the day. 

At the very minimum, the likely location of the water sources should be established before any 

planning work can be done. 

FORMAT: Google Earth KML/KMZ using the description field to add the information, or a table 

form with coordinates in the main summary document. 

 

5. Location of Existing or Planned Water Tanks  

We need the coordinates, type, volume and elevation over ground of any existing or planned 

main water tank. For example, two 10 m3 polytanks, 10 m over the ground at X, Y coordinates. 

FORMAT: Google Earth KML/KMZ using the description field to add the information, or a table 

form in the summary. 

 

6. Existing Pipes 

We need the route, pipe material, pipe diameter, pressure rating or wall thickness. For 

instance, 110 mm HDPE PE40 PN10 pipe, or HDPE 90x5.4 PN10. 

FORMAT: Google Earth KML/KMZ using the description field to add the information or water 

network map to scale that we can georeference (image, DWG, SHP). 

                                                            

4 The pump depth is helpful in determining the length of the riser pipe and calculating friction losses, but unless the 
pump is very deep compared to the water level, 100 m or more, the effect is usually negligible. 
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Figure 24. Water pipe markings explained (Source: S. Arnalich). 

 

The easiest way to find this information is in the markings that are printed every few meters on 

a pipe. In the image above: 

• PE100 is the type of HDPE. PE100 is stronger, requiring a smaller wall thickness. 

• PEHD is French for HDPE. 

• 90 x 5.4 are the outer or commercial diameter, and the wall thickness in mm. 

• PN10, is the pressure rating, 10 bar. 

 

7. Ongoing or Imminent Water Works by Any Actor 

We would need a brief description of the works and a building map if possible. 

 

8. Number and Location of Existing Water Points  

It is best to be able to site water points from the beginning, but this is not always possible. If 

there are existing water points, these need to be recorded with a GPS. 

FORMAT:  Google Earth KML/KMZ. To produce KML files from a variety of GPS native files, use: 

https://www.gpsvisualizer.com/ 

 

9. Field Constraints 

There are limitations that the designer/planner should be aware of. These limitations are usually 

in the form of what materials and which services are unavailable. For example, certain pumps 

may not be available locally, or some tanks are more widely available than others. There may 

have been problems in the past with certain materials or solutions.  

Other limitations may be the presence of natural barriers, such as wadis, cliffs, or exposed 

bedrock that may not be obvious in satellite imagery, and land ownership limitations. 

https://www.gpsvisualizer.com/
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These should be a handful of key high-level limitations, not an exhaustive list of minor concerns. 

 

10. Largest HDPE Diameter on the Market 

This limitation is so common that we would need an express confirmation of the availability of 

HDPE pipes over 110 mm.  Above this diameter, it may be hard to find pipes in some contexts 

or the manufacturing time is too long. Sometimes the pipe is available, but we cannot work with 

it. For example, HDPE welding machines for diameters over 200 mm are sometimes hard to find 

or unaffordable. The maximum diameter of standard compression fittings is usually 110 mm.  

Additionally, there may be a strong installation or transportation preference for pipes that come 

in rolls of 50 m or more over those supplied in straight 6-12 m lengths. The maximum diameter 

for HDPE PN10 pipes that typically come in rolls is 110 mm.  

 

11. Other Information 

Information such as the location of schools, offices, and health facilities can be useful but should 

not delay the response. 

FORMAT: Google Earth KML/KMZ using the description field to add the information, or a table 

form. 

SAMPLE DOSSIER 

Check the High-Level information folder in the book’s download for a template of a summary 

document and an example of these files for a fictional camp. 
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STEP 2. DEFINING THE CORE SPECIFICATIONS 

 

STABLISHING THE CORE SPECIFICATIONS OF A CAMP’S WATER SYSTEM 

With the information gathered and the information in the previous chapter, you can already 

define the approximate high-level specifications of a water system that can guide the initial 

steps. They can be later refined as necessary, but this first step is crucial to give clarity and break 

free from paralysis at the beginning of a crisis. 

This is the step-by-step process: 

1. Define the design population (P), that is, the camp size limit. 

 

2. Define the allowance (A) for the emergency (min. 15 lpd) and post-emergency phases 

(min 20 lpd). 

 

3. Define the number of people per tap (PT) for the emergency (max. 250 people) and 

post-emergency phases (max. 100 people). 

 

4. Define the number of taps per water point (TWP) for emergency and post-emergency 

phases. Usually, 12 and 6 are a good compromise between construction effort and 

service, but it depends on the context, the density of the camp, etc. When feasible, 

building the water points in the emergency phase already in their final location and 

configuration avoids duplication of efforts later and wasting resources later. For 

instance, rather than building a 12-tap water point in a line to meet the emergency 500 

m walking distance limit, you could consider 6-tap water points at shorter distances to 

improve the service and avoid decommissioning and rebuilding of infrastructure later. 

 

5. Decide on the duration of the distribution times (DT). Most camps seem to distribute 

for between 4-6 hours per day. It is not very useful to plan longer distribution times as 

water is likely to be exhausted earlier. Remember that shorter distribution times than 8 

hours necessarily need increased tap yields of at least 0.2 lps. 

 

6. Decide on the duration of the pumping times (PT). The main issue here is diesel vs. solar 

pumping. While diesel pumping can be stretched even beyond 20 h, solar pumping is 

usually limited to 5 or 6 sun peak hours, meaning that the pumping flows may be several 

times higher, and the pipes and tanks required to handle the bigger. Usually, solar comes 

later in the post-emergency phase together with a consolidation of the water sources.  

 

7. Decide on a percentage of institutional flow (I). The main factor is the proportion of the 

population in school age, which is very context specific. The institutional flow will be 

between 9-15% for the emergency phase and 7-11% for the post-emergency phase.  

GOAL:  Defining the nine core specifications of the planned water system. 
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8. Decide on the maximum distance from household to the water point. The maximum 

distance target in the standards is 500 m and 200 m for the emergency and post-

emergency phase respectively. The real distance will then come to the logical spatial 

distribution. Having a site plan already helps tremendously at this stage.  

 

With these decisions taken, the rest is just math: 

9. Calculate the total daily volume (DV):   DV = P x A x (1+I)/1000 (m3) 

 

10. Calculate the number of taps (T):    T = P/PT  (un) 

 

11. Calculate the number of water points (WP):   WP = T/TWP  (un) 

 

12. Calculate the tap design flow (TF):    TF = DV/(T x DT x 3600) (l/s)   

If this value is less than 0.125, use 0.125 lps instead. If distributing less than 8 hours, use 

0.2 lps.      

13. Calculate the water point design flow (WPF):    WPF = TF x TWP (l/s) 

 

14. Calculate the design peak distribution flow (DF):  DF = T x TF  (l/s) 

 

15. Calculate the design pumping peak flow (P):   PF = DV/(PT x 3.6) (l/s) 

 

16. Assess the minimum storage volume (S):   S = DV x 0.3  (m3)  

 

A strict minimum of 30% will be needed. The more mismatch between pumping and 

distribution hours, the more storage that will be required.  

 

It is important to remember that speed beats accuracy in this context. Working with a good 

enough assumption avoids analysis paralysis. The process can always be refined later if more 

information is available. The following chapters add information to make these initial choices 

more accurate. Let’s get more familiar with the steps with the following example. 

 

Exercise 6.1: Defining the Core Specifications 

The newly established Dougi refugee camp5 currently hosts 34,721 refugees, with a maximum 

capacity of 50,000, of whom 37.5% of the refugees are of school age. Water is presently being 

supplied through trucking, while the first boreholes are under development. Outline the high-

level parameters for the response for the emergency phase. 

 

                                                            

5 All data referring to Dougi is fictional. 
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DEFINITIONS: 

1. Design population: 50,000 people 

2. Allowance: 15 lpd 

3. People per tap: 250 people 

4. Taps per water point: 6 taps6   

5. Distribution time: 5 hours7 

6. Pumping time: 14 hours8 

7. Institutional flow: 10%9 or 0.1 

8. Maximum distance from household to the water point: 500 m 

CALCULATIONS: 

9. Total daily volume:     DV = 50000 x 15 x(1+0.10)/1000 = 825 m3 

10. Number of taps:    T = 50000/250= 200 taps 

11. Number of water points10:   WP = 200/6 = 33.33 ≈ 34 water points. 

12. Design tap flow:    TF = 825 / (200 x 5 x 3.6) = 0.229 l/s 

13. Water point design flow:  WPF = 0.229 x 6 = 1.38 l/s 

14. Design distribution peak flow:   DF = 200 x 0.229 = 45.83 l/s 

15. Design pumping peak flow:   PF = 825 / (14 x 3.6) = 16.37 l/s 

16. Minimum storage volume11:   S = 800 x 0.3 = 248 m3 

For clarity, only the emergency phase has been calculated. However, it is crucial to consider both 

emergency and post-emergency phases from the very beginning, and not just the emergency.  

By placing the specifications of both phases next to each other, the evolution of needs become 

clear, making the transition smoother and more resource efficient. 

 

DEFINITIONS Post-emergency Emergency Unit  
Design population 50000 50000 p  

Allowance 20 15 lpd  

People per tap 100 250 p   

Number of taps per water point 6 6 un  

Distribution time 6 5 h  

Pumping time 912 14 h  

Institutional flow 7.5% 10.0% un  

Max. dist. to water point 200 500 m  

     

                                                            

6  Avoids unnecessary decommissioning and rebuilding of water points by building in their final form and location. 
7 Three hours in the morning, where there is more demand. 
8 While the boreholes are unfinished and initial pumping may be longer, that situation will be short-lived, and pumping 
long hours complicates operation. Transition to solar pumping may not happen until well into the post-emergency 
phase. 
9 Corresponding to 40% of the refugees of school age. More details in the next exercise. 
10 Rounded up to the next whole number. 
11 A 35% storage volume could be achieved with three T95 Oxfam tanks.  
12 The number of hours will depend on each site; here a hybrid system has been considered. 
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CALCULATIONS Post-emergency Emergency Unit Commentary 

Total daily volume 1,075 825 m3   

Number of taps  500 200 un   

Number of water points 83.33 33.33 un Take the next whole number 

Minimum required flow 0.100 0.229 lps   

Design tap flow 0.125 0.229 lps Override to 0.125 if lower 

Water point design flow 0.75 1.38 l/s   

Distribution peak design flow 62.50 45.83 l/s   

Pumping design flows 33.18 16.37 l/s   

Minimum storage needs (30%) 323 248 m3   

 

For an Excel template, find the file STEP2. Core Specifications Template.xlsx in the book’s 

download. 

For quick planning and budgeting purposes, the emergency phase develops roughly 75% of the 

post-emergency intervention: 

• 75% of the water source capacity. 

• 75% of the storage capacity. 

• 66% of the distribution pipes. 

• 50% of the pumping main capacity. 

• 33% of the water points.       

INSTITUTIONAL DEMAND: SCHOOLS, MEDICAL FACILITIES AND OTHER 

As we have seen, institutions are not planned in detail. There is no need to pinpoint their exact 

locations and needs at this stage. This would consume precious time with no benefits. Rather, 

their water use is taken as a percentage of the domestic consumption, and their locations can 

be decided later. This is another benefit of having minimum diameters. 

The main source of institutional demand is schools, with an allowance of 3 liters per pupil. The 

proportion of school-age children is usually important, sometimes being up to 60% of the 

refugees. 

For health facilities, the standard prescribes 10 liters/visit for outpatients and 50 liters/bed for 

inpatients. On average, in camps, there are three outpatient visits per person per year13, and the 

Sphere Standard health section prescribes a minimum of 18 inpatient beds per 10,000 people. 

For all other facilities, a ballpark figure can be considered, for example, 1% or 0.2 lpd. 

                                                            

13 Weiss, W.M., Vu, A., Tappis, H. et al. Utilization of outpatient services in refugee settlement health facilities: a 
comparison by age, gender, and refugee versus host national status. Confl Health 5, 19 (2011). 
https://doi.org/10.1186/1752-1505-5-19 
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Exercise 6.2: Assessing Institutional Demand 

Determine Dudah’s institutional demand percentage, as was used in the previous exercise. 

 

A. SCHOOLS: 

For a population of 50,000 and 37.5% school-age children, we can expect: 

50,000 people x 0.375 x 3 lpd = 56,250 liters/day  

 

B. HEALTH FACILITIES: 

For outpatients with 3 visits per year on average: 

 50,000 people x 3 visits/year x 10 liters/visit x 1 year / 365 days = 4,110 liters/day 

For inpatients, with 18 beds per 10,000 people, there will be 18 x 5 = 90 beds. 

 90 beds x 50 liters/visit = 4,500 liters 

The total for health facilities is 4,110 + 4,500 = 8,610 liters 

 

C. OTHER: 

Considering 1% or 0.2 lpd, other institutions we can plan: 

 50,000 people x 0.2 lpd = 10,000 liters,  

 

D. TOTALS: 

The total institutional demand is 56,250 + 8,610 + 10,000 = 74,860 liters 

The emergency domestic demand is 50,000 people x 15 lpd = 750,000 liters.  

The post-emergency domestic demand is 50,000 people x 20 lpd = 1,000,000 liters. 

 

Given the relatively small proportion of institutional demand compared to domestic demand, 

we can approximate the percentages using the following simplified expressions: 

 Emergency phase:   74,860 / 750,000 ≈ 10% 

 Post-emergency phase:  74,860 / 1,000,000 ≈ 7.5% 

 

The following template, shown below, has all these operations built in for ease of use. You can 

find it as a tab of the file STEP2. Core Specifications Template.xlsx in the book’s download. 
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INSTITUTIONAL FLOW CALCULATOR 
   

Population  50000  
Proportion of school-age children 37.5%  
Outpatient visits per person per year 3  
Min inpatient beds per 10000 18  

   

Pupil allowance 3 lpd 

Outpatient 10 lpd 

Inpatient 50 lpd 

Other services 0.2 lpd 

   

Schools 56250 l/d 

Medical centers 8610 l/d 

Other services 10000 l/d 

TOTAL 74860 l/d 

   

Institutional flow (emergency) 10.0%  
Institutional flow (Post-emergency) 7.5%  
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STEP 3. SIZING PUMPS AND PUMPING MAINS 

 

To be able to size the pump, we must choose a pipe diameter for the pumping main first. 

PUMPING MAIN SIZING 

Size your pumping mains to have a 1-5 m/km headloss.  

This range provides usually the minimum total cost, the lowest combination between 

operational costs (OPEX) and investment costs (CAPEX). Installing diameters that are too small 

ends up being much more expensive in the long, medium, and even short time! This isn’t the 

time or place to cut corners. 

 

 
 

Figure 25. The total investment and operational cost for eight different pipe sizes are compared against unit friction 
losses for a 10 year period. While a 75 mm pipe costs $3,300, it ends up being four times more expensive than a 125 
mm pipe when considering long-term costs. The initial pipe purchase is usually the lesser cost. 

 

In the absence of precise information, you can use the following table to size  and optimize 

pumping mains: 

 

GOAL:  Optimize life-cycle costs to avoid hefty legacy costs from poor decisions.  
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PUMPING MAIN SIZING CHART (HDPE PN10 PE100) 

l/s  ⌀63 ⌀75 ⌀90 ⌀110 ⌀125 ⌀140 ⌀160 ⌀180 ⌀200 l/s  

0.5 1.2 0.5 0.2 0.1 0.0 0.0 0.0 0.0 0.0 0.5 

1 4.3 1.8 0.7 0.3 0.1 0.1 0.0 0.0 0.0 1 

1.5 9.1 3.7 1.6 0.6 0.3 0.2 0.1 0.1 0.0 1.5 

2 15.5 6.4 2.7 1.0 0.5 0.3 0.2 0.1 0.1 2 

2.5 23.4 9.6 4.0 1.5 0.8 0.5 0.2 0.1 0.1 2.5 

3   13.5 5.6 2.1 1.1 0.7 0.3 0.2 0.1 3 

4   23.0 9.6 3.5 1.9 1.1 0.6 0.3 0.2 4 

5     14.5 5.3 2.9 1.7 0.9 0.5 0.3 5 

6     20.3 7.5 4.0 2.3 1.2 0.7 0.4 6 

7     27.0 9.9 5.4 3.1 1.6 0.9 0.5 7 

8       12.7 6.9 4.0 2.1 1.2 0.7 8 

9       15.8 8.6 5.0 2.6 1.5 0.9 9 

10       19.2 10.4 6.0 3.1 1.8 1.1 10 

11       22.9 12.4 7.2 3.7 2.1 1.3 11 

12       27.0 14.6 8.5 4.4 2.5 1.5 12 

13         16.9 9.8 5.1 2.9 1.7 13 

14         19.4 11.3 5.8 3.3 2.0 14 

15         22.1 12.8 6.6 3.8 2.2 15 

16         24.9 14.4 7.4 4.3 2.5 16 

17         27.8 16.2 8.3 4.8 2.8 17 

18           18.0 9.2 5.3 3.1 18 

19           19.9 10.2 5.9 3.5 19 

20           21.8 11.2 6.5 3.8 20 

21           23.9 12.3 7.1 4.2 21 

22           26.1 13.4 7.7 4.6 22 

23           28.3 14.5 8.4 4.9 23 

24             15.7 9.0 5.3 24 

25             17.0 9.8 5.8 25 

USAGE: Select a pipe diameter in the row for the planned flow to achieve a unit headloss between 1 
and 5 m/km (green cells). For a 10 l/s flow, select either a 160 or 180 mm pipe (Source: S. Arnalich). 

 

To use the charts: 

1. Go to the relevant chart, either PN10 or PN16. For PVC, just use the HDPE equivalent. 

2. Go to the row with the closest figure to the planned flow. 

3. Find the cells with unit headlosses between 1 and 5 m/km. They are shaded in green 

with bold font. 

4. Move up in their rows to find the pipe diameters.  

5. Don’t be tempted by smaller, cheaper pipes – they’ll cost you much more in the long 

run! 
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For 16 bar HDPE, PN16, use the following chart: 

PUMPING MAIN SIZING CHART (HDPE PN16 PE100) 
l/s  ⌀63 ⌀75 ⌀90 ⌀110 ⌀125 ⌀140 ⌀160 ⌀180 ⌀200 l/s  

0.5 1.7 0.7 0.3 0.1 0.1 0.0 0.0 0.0 0.0 0.5 

1 6.2 2.6 1.1 0.4 0.2 0.1 0.1 0.0 0.0 1 

1.5 13.1 5.5 2.3 0.8 0.4 0.3 0.1 0.1 0.0 1.5 

2 22.3 9.3 3.9 1.4 0.8 0.4 0.2 0.1 0.1 2 

2.5 33.8 14.1 5.9 2.1 1.2 0.7 0.3 0.2 0.1 2.5 

3   19.8 8.3 3.0 1.6 0.9 0.5 0.3 0.2 3 

4   33.7 14.1 5.0 2.8 1.6 0.8 0.5 0.3 4 

5     21.3 7.6 4.2 2.4 1.2 0.7 0.4 5 

6     29.8 10.7 5.8 3.4 1.7 1.0 0.6 6 

7     39.7 14.2 7.8 4.5 2.3 1.3 0.8 7 

8       18.2 10.0 5.8 2.9 1.7 1.0 8 

9       22.7 12.4 7.2 3.7 2.1 1.3 9 

10       27.5 15.1 8.8 4.5 2.5 1.5 10 

11       32.9 18.0 10.4 5.3 3.0 1.8 11 

12       38.6 21.1 12.3 6.2 3.6 2.2 12 

13         24.5 14.2 7.2 4.1 2.5 13 

14         28.1 16.3 8.3 4.7 2.9 14 

15         31.9 18.6 9.4 5.4 3.3 15 

16         35.9 20.9 10.6 6.1 3.7 16 

17         40.2 23.4 11.9 6.8 4.1 17 

18           26.0 13.2 7.5 4.6 18 

19           28.8 14.6 8.3 5.0 19 

20           31.6 16.1 9.2 5.5 20 

21           34.6 17.6 10.0 6.1 21 

22           37.7 19.2 10.9 6.6 22 

23           41.0 20.8 11.9 7.2 23 

24             22.5 12.8 7.8 24 

25             24.3 13.9 8.4 25 

USAGE: Select a pipe diameter in the row for the planned flow to achieve a unit head loss between 1 
and 5 m/km (green cells). For a 10 l/s flow, select either a 160 or 180 mm pipe. 

 

Avoid using PVC for pumping mains HDPE is more resistant and versatile. If assessing a PVC 

pumping main, you can refer to the HDPE chart, as the results will be nearly identical. 

 

Exercise 7.1: Sizing a Pumping Main 

Size a 4.5 km pumping main for a planned flow of 21 m3/h. 

Changing the units to l/s, divide by 3.6:    21/3.6= 5.83 l/s. 

The closest row is that of 6 l/s. We follow the row to find the first option, 160 mm for a 4 m/km 

unit headloss: 



A Step-by-Step Manual for UNHCR and Partners   66 

 

PUMPING MAIN SIZING CHART 

l/s  ⌀63 ⌀75 ⌀90 ⌀110 ⌀125 ⌀140 ⌀160 ⌀180 ⌀200 l/s  

0.5 1.2 0.5 0.2 0.1 0.0 0.0 0.0 0.0 0.0 0.5 

1 4.3 1.8 0.7 0.3 0.1 0.1 0.0 0.0 0.0 1 

1.5 9.1 3.7 1.6 0.6 0.3 0.2 0.1 0.1 0.0 1.5 

2 15.5 6.4 2.7 1.0 0.5 0.3 0.2 0.1 0.1 2 

2.5 23.4 9.6 4.0 1.5 0.8 0.5 0.2 0.1 0.1 2.5 

3   13.5 5.6 2.1 1.1 0.7 0.3 0.2 0.1 3 

4   23.0 9.6 3.5 1.9 1.1 0.6 0.3 0.2 4 

5     14.5 5.3 2.9 1.7 0.9 0.5 0.3 5 

6     20.3 7.5 4.0 2.3 1.2 0.7 0.4 6 

7     27.0 9.9 5.4 3.1 1.6 0.9 0.5 7 

 

The other options are 140 mm (2.3 m/km) and 160 mm (1.2 m/km). Since the pumping main is 

long, the last two options might not be affordable.  

If the maximum available pipe size is 110 mm, you could install it and slightly increase the 

pumping time to achieve a 5 l/s flow.  

If there’s uncertainty about the wells or plans to increase production, consider opting for larger 

pipes in the 1-5 m/km range. For example, the 140 mm pipe handles flows up to 9 l/s, and the 

160 mm pipe up to 13 l/s (see unclipped chart on the previous page). 

PUMP SIZING 

To size a pump is to choose a pump that matches closely the installation requirements. We need 

to find out the duty point, that is, the pair comprised of yield and total pumping head (i.e. 20 

m3/h, 78 m). The yield is usually known, and the head can be calculated from the installation 

characteristics. 

It is vital to size pumps accurately. Pumps running outside their duty point are a recipe for 

disaster—inefficient, prone to breakdowns, and driving up operating costs significantly. A good 

quality pump lasts 10-20 years provided it is working near its intended duty point and avoids 

harsh conditions (high sand content, aggressive water chemistry, or frequent cycling). 

 

Best Efficiency Point (BEP) 

BEP is the duty point at which the pump operates with maximum efficiency. It is the point at 

the top of the efficiency curve, the hill-shaped curve highlighted at the bottom. The further away 

from BEP, the more unsustainable the operation —increased energy costs and maintenance, 

and decreased lifespan: 
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Figure 26. Operational problems of pumps operating outside BEP. 
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Typically, we distinguish three sizing bands according to how much they deviate from the BEP’s 

flow rate:  

• Best:  90-105% 

• Better: 80-110% 

• Good:  70-115% 

 

Avoid installing pumps that operate above 115% or below 70% of the flow. 

Notice that pumps are twice as tolerant to being undersized as oversized, so it’s 

better to err on the smaller side and avoid “just to be sure” oversizing. 

 

Exercise 7.2. Pump Sizing Bands  

Calculate the sizing brackets for an AC 15 pump with a BEP deviation % of 17.3 m3/h. 

Multiply the BEP flow, 17.3 m3/h, by the percentage of each bracket: 

Best (90-105%):  17.3 x 0.90 = 15.6 m3/h and 17.3 x 1.05 = 18.2 m3/h             

Better (80-110%):  17.3 x 0.80 = 13.8 m3/h and 17.3 x 1.10 = 19 m3/h 

Good (70-115%):  17.3 x 0.70 = 12.1 m3/h and 17.3 x 1.15 = 19.9 m3/h 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 27. Sizing bands for a pump. Notice how there is more sizing margin to the left, for smaller flows. It is better to 
undersize than oversize! 
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Exercise 7.3. Appraising an Installed Pump 

An AC 15 pump is pumping 14 m3/h, what is the BEP deviation %? Is it acceptable? 

From the previous exercise we know that QBEP = 17.3 m3/h. The new duty point is QDP = 14 m3/h 

% = QDP/ QBEP x100 = 14/17.3 x100 = 81%. 

It is in the better category, therefore acceptable. 

PUMPING HEAD 

To determine the total pumping head we use three components: 

1. The geometric head hg, the altitude difference between the surface of the water in the 

source and the surface of the water in the delivery point, the tank’s overflow.   

Remember, it is the water surface that matters, NOT the pump depth! 

This is sometimes so hard to debunk in people’s minds, yet so easy to 

visualize… Imagine raising a bucket dropped in a well. We only feel the 

weight when the bucket leaves the water surface. For the pump is the 

same thing, that is why we only count from the surface. 

2. The friction head hf hare the headlosses along the pumping main. We will usually 

calculate them with EPANET, but we can use headloss charts or equations. 

 

3. The velocity head hv is the energy required to get the water up to speed. In water 

distribution systems the velocity is very low, and it can be considered negligible. 

 

H = hg + hf + hv  

Lastly, there is NO safety margin to be applied. If for some reason the head ends up being higher 

than expected, the pump will adjust along the SQ curve, trading lesser flow for more head.  

 

Adding safety margins is likely to endanger boreholes. Adding a 5-10 m of head 

“just in case” can easily lead to 30-40% increases in flowrate, exceeding the safe 

yield of wells. 

 

The total head H becomes:  H = hg + hf + hv  

 

Exercise 7.4. Pumping Head Determination 

A 2 km, HDPE 160 mm pumping main carries 5.2 l/s. The tank’s overflow is at 150 m of 

elevation, the borehole head at 100 m, the drawdown is 70 m and the pump installation depth 

is 133 m. What is the total pumping head? 
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1. The geometric head is surface of the water to the borehole to that at the tank outlet.  

 

  hg = 70+ (150-100) = 120 m 

 

2. The friction head we take from the relevant chart to 

keep the exercise straight to the point. For 5 l/s, the 

unit headloss J is 1.9 m/km. For two km, it is double 

that: 

hf = J x d = 1.9 m/km x 2 km = 3.8 m 

3. The velocity head is zero14.  

 

The total pumping head is H = hg + hf + hv = 120 + 3.8 + 0 = 123.8 m.  

The duty point of the pump is DP: Q = 2 l/s, H = 123.8 m. 

Notice again that we ignored the pump depth and that we didn’t add any safety margin. Most 

of the time, the tank base elevation is good enough to substitute for the outlet, as it is a standard 

measurement and only a few cm lower than the base. 

All that remains is selecting the pump.  

SELECTING THE PUMP 

Different pumps working at or near their BEP can still have significant variations in efficiency. 

One pump may peak at 56%, while another one at 66%. While this may not seem like big 

difference, the latter is a much better choice. It saves 20% or the energy bill!  

This is what pump selection is about: choosing the best suitable pump within and across 

manufacturers. Use pumping curves or online sizing tools from various manufacturers to 

determine the best pump for your application. 

There may be other very relevant criteria such as the pump frequency or its diameter. As a 

reminder, there should be at least 1” of clearance around a pump, so a 6” borehole can fit 4” at 

most. 

CALCULATING ENERGY CONSUMPTION 

Calculating the energy consumption is key to evaluating operating costs, fuel requirements and 

benchmark different investment options: 

 

                                                            

14 The water velocity is 0.51 m/s. Then hv = v2/2g = 0.512/19.6 = 0.013 m ≈ 0. 
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Estimation 

The following approximation is easy to remember and produces results that are within a few 

percentage points of the true value.  

E(Wh) ≈ 4m4 

Where m4, called cubic meter-meter, represents the product of the volume of water (m3) and 

pumping head (m). For instance, raising 20 cubic meters of water to a height of 10 meters results 

in 200 m4. You can think of a unit as the total effort needed for the setup and flow requirements. 

 

Precise Calculation 

The following formula is more accurate if the efficiency of the particular pump is known.  

E(kWh) = mgh/3,600,000η 

 Where: m is the mass of water in kg, 

  g is the acceleration of gravity or 9.8 m/s2, 

  h is the total head, and 

  η is the pump’s wire to water efficiency. Values are usually around 65% or 0.65. 

 

You should also use the rough calculation to verify the results. It is easy to make mistakes, and 

the stakes are high. It is too easy to add an extra zero while typing 3600000! 
 

 

Exercise 7.4. Pump Energy Consumption  

A pump with an efficiency of 65% is pumping 50 m3 to a reservoir 20 meter higher. Calculate 

the daily energy consumption. 

 

Precise calculation: 

 

E(kWh) = mgh / 3600000η = 50000 kg x 9.8 m/s2 x 20 m / 3600000 x 0.65 = 4.19 kWh 

Estimation: 

E(Wh) ≈ 4m4  = 4 x (50 m3 x 20 m) = 4000 Wh, or 4 kWh 

As you can see, they both give similar results.  

 

Estimating Diesel Consumption 

Under field conditions, generators burn around 0.42 liters of diesel per kWh. Properly sized 

generators working with loads of between 70-90% are more fuel efficient, consuming about 0.3 

kWh. 
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We can expect a generator powering the pump in the previous exercise to consume 4 kWh x 

0.42 l/kWh = 1.68 liters of diesel. 

 

Case: Assessing the legacy costs of Bh-12’s pumping main. 

The pumping main is a 4.5 km, HDPE 110 mm, PN10 pipe with a flow of 12 l/s. 

From the PN10 chart we can see that the unit headloss is 27 m/km. For 4.5 km, the total friction 

headloss is:  

hf = J x d = 27 m/km x 4.5 km = 121.5 m 

 

As you can see, only the frictional headloss, at 12.15 bar, is already exceeding the pipe’s pressure 

rating of 10 bar. This explains the reports from the field that pipes burst and disconnect 

frequently.  Back in the chart, to bring this pumping main to the economic range we would need 

at least a 160 mm pipe, with a unit headloss of 4.4 m/km: 

hf = J x d = 4.4 m/km x 4.5 km = 19.8 m 

Notice that this pressure no longer exceeds the pressure rating for PN10. To calculate the 

potential savings that would come from proper pipe sizing, we establish the difference of heads 

between the two cases:   

Excess friction head = 121.5 m – 19.8 m = 101.7 m. 

Assuming a pump efficiency of 65%, a generator efficiency of 0.45 l/kWh, and 10 hours of diesel 

pumping for a total 432,000 liters of water per day, the yearly excessive diesel consumption 

would be: 

         E(kWh) = mgh / 3600000η = 432,000 kg x 9.8 m/s2 x 101.7 m / 3,600,000 x 0.65 = 184 kWh 

         Yearly costs = 365 days x 184 kWh/d x 0.45 l/kWh = 30,322 liters of diesel. 

 

At $1.4/l, the total excess cost would be $42,310 per year. 

Now, let’s consider the effect of incorrect pump sizing alone. The pump operates far from its 

best efficiency point (BEP) of 65% due to improper sizing and selection, reducing its actual 

efficiency to 50%. 

 

 65% / 50% = 1.3, meaning 30% more energy is used. 

 

Over a year, $42,310 x 0.30 = $12,693 of excess cost, enough to pay for a new pump! 

 

The incorrect sizing of the pumping main and pump for this borehole alone costs 

$55,000 per year—adding up to over half a million USD over the pump’s 10-year 

lifespan! 
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STEP 4. SIZING AND SITING WATER TANKS 

 

TANK SIZING 

Sizing a tank requires three reserves: 

1. The operational reserve to act as a buffer during daily operations. 

2. The service reserve to step in when there are breakdowns. 

3. The fire reserve for firefighting. 

There is also the minimum requirement imposed by chlorination. The travel time in the pipes 

and residence time in tanks must be at least the chlorination contact time, typically taken as 30 

minutes in refugee settings. 

Lastly, storage should prevent frequent pump starts (pump cycling) to avoid wear and 

inefficiency. Unless designed for frequent starts, keep pump activations below four per hour, or 

follow the manufacturer’s guidelines. 

 

Sizing the Operational Reserve 

The size of the reserve is directly influenced by how pumping and distribution schedules are 

managed. When water is pumped and distributed simultaneously, storage needs are minimized 

or even eliminated. This highlights a key concept: by thoughtfully adjusting the timing of 

pumping and distribution, you can dramatically reduce the number of storage tanks required.  

 

Estimation and Target Setting 

You can roughly estimate the reserve depending on the pumping time (t), using following 

expression:  

 Storage (%Vd) = 3t          I.e. pumping 10 hours will require a 30% of the daily volume. 

 

You should use this expression as a first step to set the expectation for the precise sizing that 

follows: 

 

Precise Sizing 

To size it precisely, you will use a virtual reservoir with the following expression: 

Storage volume  = VMaximum - VMinimum  All units are the same, normally m3. 

 

GOAL:  Use tank sizing and siting strategies to optimize investment, operation and service. 
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Figure 28. Evolution of the 
water volume in a virtual tank 
in a 24h cycle. The operational 
reserve is the difference 
between the maximum and 
minimum levels. (Source: S. 
Arnalich) 

 

 

 

 

 

 

The most convenient way to do this is in a spreadsheet, with four columns:  

 

 

 

 

A. Demand – volume distributed per hour.  

B. Supply – Volume pumped per hour. 

C. Balance (for the hour), supply minus demand. 

D. Total or accumulated balance, adds each hour's balance to the previous total, creating 

a running total over time. 

You can find a template in EpaRef.zip, the book resources’ zip file. An example follows in the 

next exercise. 

 

It is very important that the amount pumped and distributed for a 24h period is 

the same. If you input that you will pump 1000 m3 but only distribute 200 m3, the 

calculation will result in 800 m3 of unnecessary storage. 

 

Exercise 8.1. Tank Sizing  

Size the storage needed for an operation pumping 60 m3/h for 10 hours and distributing for 5. 

The total volume would be 60 m3/h x 10 h = 600 m3. 
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Approximate calculation: 

As an approximation, reserve % will be three times the distribution time: 3 x 10 = 30 or 30%. 

The volume will be approximately 600 m³ x 0.30 = 180 m³.  

 

Exact calculation: 

 

 Supply Demand  Balance Total m3 

1:00 0 0 0 0 

2:00 0 0 0 0 

3:00 0 0 0 0 

4:00 0 0 0 0 

5:00 0 0 0 0 

6:00 0 0 0 0 

7:00 0 0 0 0 

8:00 60 120 -60 -60 

9:00 60 120 -60 -120 

10:00 60 120 -60 -180 

11:00 60 0 60 -120 

12:00 60 0 60 -60 

13:00 60 0 60 0 

14:00 60 120 -60 -60 

15:00 60 120 -60 -120 

16:00 60 0 60 -60 

17:00 60 0 60 0 

18:00 0 0 0 0 

19:00 0 0 0 0 

20:00 0 0 0 0 

21:00 0 0 0 0 

22:00 0 0 0 0 

23:00 0 0 0 0 

0:00 0 0 0 0 

 600 600 Volume 180 

 

 

We would need 180 m3, two T95 tanks.  

 

Without the rough calculation, you might have settled for nearly double the storage 

requirement (right table). Just by removing two hours between pump shifts, we nearly halve the 

storage needs. Before deciding to install additional tanks, explore whether simply adjusting the 

schedules can deliver the same result! 
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Effect of Solar Pumping in Tank Sizing 

Solar pumping concentrates the pumping in the central hours of the day, those with less 

consumption. There is an important mismatch between when the water is produced and 

consumed, requiring more storage. 

Early in the morning is the most convenient time for users to collect the water. Unfortunately, 

most systems wait until some of the tanks fill before starting to distribute somewhere around 

noon. By shifting the distribution to start early in the morning with the tanks filled the previous 

afternoon, we can improve drastically the service to the user.  

 

 

 

 

 

 

 

 

As an example, when this change was implemented in Dzaleka Refugee Camp, water tap use 

went up from 8% to 46% in just a year! 

 

Sizing the Service Reserve 

Unfortunately, resources in refugee settings are so limited that it would be a luxury to have 1-3 

days of reserve common in other settings. We leave its size to the discretion of the planner in a 

specific context. 

 

Sizing the Fire Reserve 

Ideally 1-2 hours of flow should be provided. 

Whatever the reserve, the real danger is having 

even the smallest fire start with the tanks 

completely empty and the system dry. To avoid 

this situation, it is vital that this reserve is held 

separately in a dedicated tank, or as part of the 

existing tanks but separated by operational 

controls, as in the image on the side.   

 

Figure 29. Improving service convenience by shifting the distribution to the 
morning in solar pumped systems. (Source: S. Arnalich). 
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TANK SITING STRATEGY 

An effective water tank siting strategy makes the operation simpler, unlocks massive economies 

both in investment and operation, and promotes equity of access. 

There are three rules to locate water tanks: 

 

RULE 1. Keep Them Close 

Place them centrally and dominating areas whenever possible, thus reducing the distribution 

pipe distances. This is important for two reasons: 

 

• In refugee settings, it is common to pump for 12-15 hours and distribute for just four 

or five. That means that the pumping flows are three times those of the distribution 

flows. Since pipe friction is proportional to the square of the flow, the pumping side 

has 9 times less friction than the distribution side. Using the cheaper pumping main 

to cover more distance can lead to big savings. 

 

 

• By keeping distribution lines shorter, it is easier to provide equitable access. End-of-

line users and those in elevated areas often face pressure challenges. The longer the 

pipe, the bigger the service disparities. 

 

Avoid the mistake of defaulting to placing tanks near boreholes. You can think of 

the distribution zone as a dartboard: the closer the tank is to the center, the better 

your 'score.' Straying too far reduces efficiency and equity. 

 

RULE 2. Place Them Low 

The idea is to avoid pumping costs by decreasing the total head. Remember that these dwarf 

installation costs in the medium and longer term. Avoid raising tanks unnecessarily or “to 

provide more pressure”.  

Figure 30. By placing tanks close to the user, we can cover more distance with the cheaper pipe. S. Arnalich. 
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Additionally, divide tanks by elevation zones to avoid pumping all the water to the highest area. 

For example, if only 40% of the water is required at a higher elevation, why incur the cost of 

pumping the remaining 60% unnecessarily high? 

 

RULE 3. Smaller Is Smarter: Decentralize Tanks 

Several smaller distribution systems are often more equitable and cost-effective than a big 

centralized one. There are a few reasons for this: 

• Water traveling shorter distances loses less pressure, lowering pumping costs. 

• Distribution can be programmed at different times for different areas, reducing the 

peak flows in shared pipes, which leads to less investment, less running costs. 

• Pressure management and volume control is easier, leading to a more equitable and 

simpler distribution.  

• Leak detection and repair is facilitated. 

Distributing the tanks into a few strategic locations rather than concentrating them all in the 

same place will enable the breakup of the system into smaller, better performing units, as we 

will see later. 

 

Site and Secure Tank Locations at the Earliest 

This could very well be rule four. Prime tank locations are usually scarce and need to secured 

early on. Losing access to them means costly, inconvenient fixes. This is one of the first decisions 

to be taken. 

 

Case 8.1. Tank Siting Strategy  

The image below shows the current thinking of a centralized system. If there were no 

limitations in how the four tanks are placed, how would you do it? 

 Figure 31. Distributing tanks at varying heights reduces unnecessary pumping to the highest elevation: S. Arnalich. 
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Notice that the concentration of tanks in the same location greatly increases the run length. 

This is, for example, the trip to reach the lower left point: 

 

 

When this concern is shared with the team, they come with this improvement by applying Rule 

3, decentralize. While the distances have been shortened, they remain still higher than 

necessary. The resulting network will be unnecessarily expensive and still face equity problems: 

 

 

We apply Rule 1. While the tanks are close, they are not dominating areas. By positioning them 

centrally, piping runs are drastically shortened: 
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STEP 5. PREPARING A BACKDROP 

 

 This is an example of the kind of image we would be looking to produce: 

 

Figure 32. Backdrop for Alacha refugee camp, Chad, featuring the camp layout and the contour lines over a satellite 
image. Source: S. Arnalich. 

 

Then it would be a matter of drawing the network over it. We would: 

1. Add the image to EPANET as a backdrop. 

2. Set its dimensions. 

3. Activate auto length.  

4. Start drawing. 

The first step is to add the information we need on the image in Google Earth. The following 

needs to be added, preferably in this order: 

• UTM gridlines (or reference points). 

• Overlay of the camp site plan. 

• Contour lines obtained from a DEM. 

• Location of existing infrastructure. 

GOAL:  Create a simple map of spatial data to lay out your network. 
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9.1 ASSEMBLING THE BACKDROP IMAGE IN GOOGLE EARTH  

Configuration 

1. Open Google Earth in your desktop. You can download it by going to: 

https://www.google.com/earth/about/versions/#earth-pro 

 

2. Go to Tools > Options. 

 

3. In the 3D View tab, select Universal Transverse Mercator (UTM) and set the units to 

Meters, Kilometers: 

 

 

 

 

 

 

 

 

4. Click Apply and exit. 

 

Adding Reference Points or UTM Grids 

To provide information about the image’s real-life dimensions in EPANET, you can either create 

two reference points or add UTM gridlines (preferable).  

Adding two reference points 

1. Use the add placemark icon to add two reference points, one in the lower-right corner 

(LL) and one in the upper-right corner (UR), ensuring they span the entire area of 

interest: 

 

 

 

 

 

2. Copy the pins’ coordinates for later use in EPANET. 

https://www.google.com/earth/about/versions/#earth-pro
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Figure 33. Lower Left (LL) and Upper Right (UR) pins, and the dialogue box where you will obtain the UTM 
coordinates to use later in EPANET, in this case, 273622 3533147 for UR. 

 

Using a UTM Grid 

A file provides the UTM grid, which is composed of 1 km x 1 km grid that provides the image’s 

real-world dimensions. By cropping the image along some gridlines and counting the number of 

squares, we get the backdrop image and its actual size. 

1. Download the KML file containing the UTM grid (search nearby.co.uk) or locate it in the 

EpaRef.zip previously downloaded. 

 

2. Go to your download folder and click on the file. Google Earth will add it to Places and 

display the gridlines: 

 

 

 

 

 

 

 

To know its dimensions, you would count the number of squares in the horizontal and vertical 

directions, i.e., 6 x 4 squares is 6 x 4 km, as simple as that. To export the pipes as a KMZ file 

later (see section 0), ensure you input the complete UTM coordinates in the dimensions box 

instead of generic values like 6000 x 4000. 
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Exercise 9.1 Preparing a Simple Backdrop 

Prepare the backdrop of a refugee camp using the site plan obtained, and a KML with the 

contour of the camp. 

1. If you haven’t already done it, download the KML file with the UTM gridline (previous 

section). 

 

2. Find the files included in the EpaRef.zip download. 

 

3. Add UTM_grid.kml and Dougi camp perimeter.kmz to Google Earth by clicking on them. 

Here I have created a folder to have all the files organized in one place: 

 

 

Next, we will add the site plan as an image overlay. To avoid having to deal with specialized 

software, always ask the site planner for a pdf printout.  

4. Use a free online PDF to JPG or PNG image formats. One of these free converters is 

https://www.ilovepdf.com/. The use of these sites is very straightforward. I leave it to 

the reader to use it, but you should come out of this process with a high-quality image.  

 

5. Use image editing software to remove the white background and make it transparent, 

as shown below. Save it as PNG to keep the transparency. Avoid JPG, as it will fill the 

transparent areas with white. 

 

https://www.ilovepdf.com/
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If you get stuck during the exercises, remember that the folder Solution Walkthrough inside the 

exercise zip contains the files created during the process. 

6. Back in Google Earth, click Add Image Overlay.  

 

 
 

 

 

7. Name it Site plan and click Browse to 

navigate to the folder containing the PNG 

image you have just prepared: 

 

 

 

Your image probably won’t match the satellite background perfectly. In the exercise, we used 

the camp contour KML to make the point clearer, but you may not have that file. Instead, you 

will have to match features on the site plan to those on the satellite image.  

8. Adjust the transparency slider (in blue) until both are visible if needed and use the green 

overlay frame markers to stretch, move, and rotate the image until it fits perfectly and 

click ok. 

 

 

 

 

 

 

 

 

 

 

9. Zoom in or out to cover the desired area, ensuring UTM gridlines extend beyond it for 

cropping later. Then go to File > Save > Save Image. 

 

Figure 34. Using the overlay frame markers to move, stretch, and rotate the image until it fits. 
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10. Clear unnecessary clutter by unchecking Title and Legend in Map Options. Set the 

Resolution to at least 1920x1080. Click on save image, naming it Dougi Backdrop. 

 

 

 

 

 

 

 

11. Open the image in an image editing software. Crop the image along the four gridlines 

that cover the entire area: 

 

 

 

 

 

 

 

 

 

 

 

12. Save the image as BMP: 
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Exercise 9.2 Loading a Backdrop in EPANET 

Load the backdrop created in the previous exercise. 

1. Open EPANET. Go to View > Backdrop > Load.  

 

2. In the dialog box, load your BMP backdrop image. It will appear. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Navigate to View > Dimensions to define the 

image's real-life size. Note that it spans 6 x 4 

squares, equivalent to 6 x 4 km. Enter the 

coordinates as follows: Lower Left (0,0) and 

Upper Right (6000, 4000), and set the units to 

Meters or use the real UTM coordinates to be 

able to export the image as KMZ later. 

 

4. Place your cursor in the image's upper-right corner and check that the coordinates 

shown in EPANET's bottom-left match.  

 

 

 

5. Right-click on the Auto-Length Off button right next to the coordinate display and select 

Auto-length On. As long as it is activated, pipes drawn in EPANET now reflect their real-

life lengths. 
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Exercise 9.3 Adding Contour Lines  

Add contour lines from FABDEM to your backdrop image 

FABDEM is, at the time of writing, the most accurate free digital elevation model we have 

evaluated. Together with a verification process we will cover in the next chapter, it provides a 

reliable way to speed up designs by making the topographic survey unnecessary. 

1. Find the decimal degrees coordinates of your location. In Google Earth you can do that  

by reverting the coordinate system to geographical > Tools > Options > 3D View > 

Decimal degrees. Read the coordinates in the lower right corner. In this case, the latitude 

is 13.13° and the longitude 21.35°. South and west coordinates are negative (i.e. -8.13°): 

 

 

 

2. Search online for the latest version of FABDEM. At the time of writing, is version 1.2 

located at: https://data.bris.ac.uk/data/dataset/s5hqmjcdj8yo2ibzi9b4ew3sn 

 

A list of file names appears, such as N00E070-N10E080_FABDEM_V1-2.zip, with coordinates in 

the name at 10° intervals. For instance, in N00E070-N10E080_FABDEM_V1-2.zip: 

• The latitude is between 0° and 10° north: N00E070-N10E080_FABDEM_V1-2.zip. 

• The longitude is between 70° and 80° east: N00E070-N10E080_FABDEM_V1-2.zip. 

 

3. Locate the file that corresponds with Dougi  (lat. 13.13° north, lon. 21.35° East). We are 

looking for the file that covers all tiles from 10 to 20° North and from 20° to 30° East: 

N10E020-N20E030. Then click on > Explore > Go to resource: 

 

 

 

 

 

 

 

The download starts. The file is 1.7 GB, make sure you have a good connection and enough time. 

Use the time to double-check that you selected the right tile, as this can be confusing. 

https://data.bris.ac.uk/data/dataset/s5hqmjcdj8yo2ibzi9b4ew3sn
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4. Once downloaded, unzip the file. File names now show 1° intervals, using the lower-left 

corner coordinates only. For example, (lat 13.13°N, lon 21.35°E) is labeled N13E021. 

Move the TIF file to the desired location. 

 

 

 

 

5. Open QGIS (available at for free at www.qgis.org). Go to > Project > New.  

 

6. Drag the TIFF image into the main workspace. 

 

 

 

 

 

 

 

To avoid the computer from freezing due to excessive data, we need to crop this file to our area 

of interest.  

7. Back in Google Earth: 

 

7.1 Click the Add Polygon icon. 

 

7.2 Draw a rough rectangle covering the area of interest by clicking its four corners. 

 

7.3 Right-click on the new polygon listed in Places and select Save place as. Name the 

file Dougi Cropping limits.kmz. 

 

 

 

 

 

 

 

http://www.qgis.org/
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8. In QGIS, go to Raster > Extraction > Clip Raster by Mask Layer … Under Mask layer. Click 

the three dots to navigate to Dougi Cropping limits.kmz and click Run. 

 

 

 

 

 

9. Delete the layer containing the larger tile image: 
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10. Go to Raster > Extraction > Contour. 

Then: 

 

10.1 Select the Clipped (mask) as Input 

layer. 

 

10.2 Set the Interval between contour 

lines to 1. 

 

10.3 Click on the Contours field, name 

the file Dougi contours, and 

select KML from the export 

options. 

 

 

We'll standardize the contour lines by adding labels. 

11. Find the contour layer in the Layers area and double click to open its properties.  

 

 

 

 

 

 

11.1 In the Symbology tab, you can change the color to make it contrast. Select black 

from the Color dropdown. 

 

11.2 Under Labels, select Single Labels from the drop menu (a). Then 1.2 ELEV in Value 

(b). In Placement, check On the line and leave the other options unchecked (c). 
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11.3 In Labels > Buffer, check Draw text buffer and increase its size to 2 mm. 

 

 

 

 

 

 

 

 

 

 

 

 

 

12. Apply and close. After deleting the source layer, your screen should look like this: 

 

 

 

 

 

 

 

 

Highlighting every fifth line for better visibility is straightforward, but beyond the scope of this 

exercise. You can find many YouTube tutorials covering the process. 

We will install a plugin to export the contour lines with their labels.  
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13. Go to Plugins >  Manage and Install Plugins …  Type KML tools in the search box, select 

the proposed plugin and click Install Plugin. Wait for the confirmation message. 

 

 

 

 

 

 

 

14. New icons appear. Click on Export KMZ: 

 

 

 

 

 

15. Select the Input layer and 1.2 ELEV as 

the Name > Label field.  

 

 

 

 

 

 

Then scroll to the end of the dialogue box, 

click on the three dots, choose a location, and 

name the file Dougi contours.kmz. Click Run to 

finish and close. 

 

 

16. Click on the layer you have just created. It should look like the image below: 
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17. Continue with the process you have seen in the previous exercises until you have loaded 

and dimensioned the complete backdrop in EPANET: 

 

 

18. Regroup all the layers in Google Earth and save them as Dougi backdrop.kmz for future 

reference, if you need more detail or changes.  

Figure 35. Contour line layer with labels in Google Earth. 

Figure 36. EPANET backdrop showing the site plan and contour lines extracted from FABDEM. S. Arnalich. 
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STEP 6. DRAWING THE NETWORK 

 

This phase is where the system is conceived, and it will affect how much it costs and how well it 

performs. It is about “connecting the dots” in the most optimal way, especially since most water 

points’ positions are typically fixed by the site plan and the minimum distance requirements. 

 

Goal 1: Efficiency – Get Straight to the Point 

The most efficient networks are those that minimize the distances between water tanks and 

water points. Shorter travel distances reduce energy loss and allow for smaller diameter pipes, 

which in turn lowers both investment and operational costs. 

Consider these two ways to connect the same water points using the same length of pipe: 

 

 

 

The network on the left is more efficient. While the distance to reach some points is the same 

(3, 14, or 23), the distance is significantly longer for many others (26, 57 or 39) as water snakes 

down the line.   

 

Assuming distances between points are 1 km and headloss is 5 m/km, reaching point 39 takes 

40 m of energy (8 km × 5 m/km) on the left network, but 70 m of energy (14 km × 5 m/km) on 

the right. And point 39 is the more challenging in terms of equity! 

For 1000 m3 per day and 1.3 USD/l of diesel, the annual cost difference from operating these 

two networks is $25,000. In ten years, $250,000 just from a 1 km pipe relocation! 

GOAL: Design the system with the most cost-effective and equitable layout. 



A Step-by-Step Manual for UNHCR and Partners   96 

 
Now, think about how flows are split in the left network. Remember, friction losses increase 

with the square of the flow. The lightly highlighted pipes in the image below split the flow 

allowing for significantly smaller diameters, and hence investments. 

 

 

 

 

 

This was already introduced in the case about tank sitting strategy in 8.2. 

 

Goal 2: Equity of Access  

Equity of access is about everyone having a fair chance to collect their allocated water. However, 

refugee camps usually produce just enough to meet the standard, and even that can be 

challenging to achieve. This often results in a zero-sum game: if some users collect more water, 

it comes at the expense of others. 

Consider the graph below. Water flow from a tap depends on pressure—the higher the pressure, 

the more water flows. At 2 m of pressure, you get 0.5 l/s, but at 30 m, it's 3.5 l/s—seven times 

more! Users at high pressure areas (low and close) win the game. The key to equity is pressure 

control. 

 

 

 

 

 

 

 

 

 

 

 

   Figure 37. Relationship between flow and pressure at a tap (Source: S Arnalich). 
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DESIGNING THE NETWORK LAYOUT FOR PRESSURE CONTROL 

There are two main strategies to use combined: 

1. Decentralizing to reduce pipe run length and network complexity. 

2. Creating pressure zones. 

 

Decentralizing 

Centralization may give the illusion of better control and reduced costs, and some people may 

resist the idea of decentralizing. Yet decentralization is the international best practice! It 

advocates for the establishment of District Metered Areas (DMA). These are isolated sections 

of a water distribution system that is isolated by valves and monitored to measure and control 

water flow, pressure, and leakage.  

Take a look at the following network where two DMA’s have been implemented. 

 

 

 

DMA 1. Notice how the water tower 

12 is centered and splits the flow 

right away in four directions. 

 

 

DMA 2. Water tower 13 could not be 

centered due to a lack of an 

adequate site, but it still splits the 

flow in three directions. 

 

To determine the number of pressure zones, you will need consider the local geography, 

elevation, and urbanization patterns. As a rough rule of thumb, aim for a DMA every 10,000-

20,000 refugees. 

 

Pressure Zones 

This concept is similar to DMAs but focuses on creating zones based on elevation to prevent 

unequal access caused by elevation differences. In the example below, break-pressure tanks 

(BPT) supply three pressure zones from the same main. However, these zones often require 

parallel distribution mains to establish DMAs as part of the same effort. 
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Figure 38. Example of pressure zone implementation using break-pressure tanks. Source: S Arnalich. 

 

For example, this approach was applied in Azraq refugee camp, using the natural topography 

where the ground slopes by 30 meters towards the central wadi  that flows east to west: 

 

Figure 39. Pressure zones planned for Azraq refugee camp (Source: S. Arnalich). 
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We aim to create a pressure zone every 8-10 m of elevation. Contour lines are very useful for 

guiding zoning: 

 

 

 

 

 

 

 

 

 

 

 

CASE 10.1. Implementing Pressure Zones  

Coming back to case 8.1, imagine a 20 m slope from north to south over the stretch of the 

image. How would that affect the layout?  

 

Here two pressure zones are implemented, notice the different pipe run lengths for point A: 

 

Figure 40. Azraq’s water network over contour lines. Zoning is shown by the dashed red lines. S. Arnalich. 
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In this setup, water distances to critical high points have been decreased, and higher points have 

been isolated from lower points to ensure equity.  

SITING THE WATER POINTS 

Site plans typically position water points at plot corners where streets intersect. This setup 

allows pipes to follow roads and ensures public oversight. In contrast, routing pipes through 

populated areas and placing water points inside plots leads to unauthorized connections, 

compromising operations and access equity. 

You will also have to place Junctions that are not water points to be able to build the network.   

It is important to place nodes at high points along the pipe run as pressure 

gauges, to ensure the pipe does not depressurize. EPANET does not warn you or 

show you pressures along the pipelines. By adding node C, we can know that 

there will be parts where the pipe depressurizes and remedy it. 

 

 

 

 

Drawing and Adding the load to the Points in EPANET 

During the tutorial in chapter four, you learned how to draw points and assign them an elevation 

and a demand:   

1. In EPANET, load the backdrop, set its dimensions, select meters as unit, and turn Auto-

length on.  

 

2. Activate the Junction button and draw the nodes. The image on the next page shows 

the positioning of such water points to ensure that walking distances are below 500 m. 

 

3. Assign elevations to the nodes by estimating 

from nearby contour lines. For example, if 

point A is halfway along between lines, its 

elevation is approximately 562.5 m. If point B is 

one-fifth of the way, its elevation is about 

564.2 m.  Submeter precision is sufficient for 

water system design. 

 

4. Assign the demand calculated in Step 2, Defining the core specifications. For instance, 

in the emergency system for Dougi (Exercise 6.1), the calculated demand was 1.38 l/s 

per point. 
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PLACING WATER TANKS 

We have discussed previously the three rules of water tank siting: 

1. Keep the close to the user, in central, dominating positions. 

2. Keep them low, to minimize pumping costs. 

3. Decentralize to serve independent systems or DMAs. 

With these rules and the topographic information the location of the tanks should be quite self-

evident. However, it is more often the case that there is not a clear prime location and 

compromises have to be made. Remember to decide on and secure tank locations as early as 

possible to avoid significant constraints later. 

We will use reservoirs rather than tanks in EPANET. As mentioned in the modeling strategies 

discussed in Chapter 4, we focus solely on the distribution system for simplicity. 

The only input required is the elevation. 

DRAWING PIPES 

Most of the information about drawing pipes has already been presented. In summary: 

1. Get straight to the point. Minimize the run distances to most points.  

2. Divide flows early on as many times as possible. 

Practically: 

• Remember to draw with Auto-length mode enabled. 

• Route pipes through roads and accessible areas. 

• Draw pipes in the direction of flow as much as possible to have positive flow values. 

• In the Diameter field, specify inner diameters, not nominal ones. 

• In Roughness, use 140 for plastic pipe (HDPE and PVC) and 120 for galvanized iron (GI). 

For simple systems with low velocities, as those of refugee camps, you can safely ignore the 

minor losses incurred in fittings such as elbows or valves (see page 44 of EpaDev). 

DRAWING PUMPS 

Pumps need to be drawn in the direction of the flow, from inlet 

to outlet. The symbol looks like a cannon, with water flowing in 

the same direction as the cannonball would: 

Keep in mind: 

• The pump icon can be deceptive—it shows a line, but don’t be fooled; the pipe isn’t 

included! 

• You’ll need to link the pump to a pump curve that you define separately. 
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DRAWING VALVES 

Shut-off valves and non-return valves are defined in Initial status as a property of the pipe 

(Open, Closed, or CV). 

Always draw valves in the direction of the flow. In EPANET, 

valves refer to automatic, directional valves with clearly defined 

inlet and outlet sides. For example, a pressure-reducing valve has 

a high-pressure side (inlet) and a low- pressure side (Outlet). 

Again, it shows a line, but the pipe is not included.  

Remember to specify the type of valve in the dropdown Type and input its Setting. For instance, 

a pressure reducing valve (PRV) with a Setting of 0 will reduce the pressure to 0. 
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STEP 7. SIZING THE NETWORK 

 

With the system laid out and data entered, it’s time to focus on sizing the network, that is, 

deciding the optimal pipe diameters, and optimizing its layout. This is an iterative, trial-and-

error process. Taking the time to explore less obvious alternatives can pay off significantly. Be 

prepared to revisit the layout if needed. 

Remember, EPANET has no undo button. Always save the base model in a safe 

location for reference and work exclusively on copies. It’s easy to get carried 

away when you’re "just trying something quickly" only to realize you can’t revert 

the changes.  

The same goes for more advanced versions you’ve worked on. To protect them, 

save consecutive versions regularly. If you’re testing something quickly, make a 

copy and move it to a Sandbox folder where you can experiment freely without 

ruining your previous work. 

 

Familiarizing Yourself with Your System 

Water systems are unique, each with its quirks—much like people. Taking the time to get to 

know your system by experimenting different approaches, rather than rushing to a solution, can 

lead to important insights. Your first attempt is rarely the most optimal. 

 

Gamify Your Design and Benchmark Your Results 

Your system might be simple, but it’s probably complex enough to benefit from several 

benchmarked attempts. Think of it like playing a video game. Try different strategies in several 

game rounds. Then see which one is more cost-effective. A few hours of trials may be worth 

years of salary! 

 

Work Your Way Downstream 

Since any change in pipe size upstream affects all downstream parameters, start with the 

upstream pipes and work your way downstream. Otherwise, could end up in a whack-a-mole 

situation, where each change disrupts your previous sizing work. 

 

Headloss Enlightment 

Unit headloss is not a calculation parameter, but it is incredibly useful for understanding a 

system and identifying potential issues or areas for improvement. In just one glance, it provides 

valuable insights into where to start. 

Take a look at this system in the ne, for example—where would you begin? Pretty daunting, 

right? 

GOAL: Ensure cost-efficiency, reliability and equity with adequate service levels. 
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With just pressure, it’s hard to know where to start and what should be attempted first. Now, 

look at the image on the next page. By displaying unit headloss, much of the complexity 

disappears. At first glance, you can see choked pipes (1 and 3)—those with recklessly small 

diameters. You can also see some diameters are too generous (4) and even some pipes are 

closed (3).  

By simply changing the offending pipes closer to the tank (1, 2, and 3) and adjusting their unit 

headloss back to the range of 3-7 /km, the system would be functional again. Compare this with 

blindly trying to increase diameters. 

 

Figure 41. Where to start?  (Source: S. Arnalich). 
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Figure 42. Mains 1 and 2 have headlosses of up to 140 m/km, and main 3 is closed. No wonder the system didn’t work! 
(Source: S. Arnalich). 

 

Pressure only tells part of the story; you need unit headloss for the complete picture and to 

hone in on a solution quickly. 

RECAP OF HYDRAULIC CRITERIA 

These were introduced in Chapter 3.  

1. Minimum working pressure:   10 m (7 m exceptionally in a few points). 

2. Working pressure range at tap:   10-20 m. 

3. Tentative maximum working pressure:   45 m. 

4. Velocity:  Below 2.5 m/s. Remember there is NO minimum velocity. 

Aim for tentative unit headloss of 3-7 m/km for distribution mains and 1-5 m/km for pumping 

mains, when no rigorous economic analysis is performed. 
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OVERCOMING ERRORS 

See pages 129-135 of EpaDev. 

VISUALIZING RESULTS 

Once you run the simulation by clicking Run, and have read and dismissed the messages, your 

screen will not have changed much. To see the results, head over to the Browser and select 

criteria from the Nodes and Links dropdown menus. 

 

 

 

 

 

 

 

 

 

Always run the simulation after making any changes to the model; otherwise, 

EPANET will display results from the previous simulation, ignoring the updates. If 

changes were made without running a simulation, EPANET will indicate this with a 

broken tap icon in the bottom left corner: 

 

 

 

To display values, add flow arrows or even change the 

background color, right-click anywhere on the screen to 

open Map Options. Under Notation (1) check Display Node 

Values and Display Link values to show values by nodes 

and pipes. Under Flow Arrows (2), activate them by 

selecting an Arrow Style. Arrows are essential to verify that 

water in the model is doing what it should—for example, 

flowing from pumps to tanks and not the other way 

around! 
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Personal Setup 

When starting this phase, I follow these steps: 

1. Unload the backdrop. 

2. Set the Browser to display Pressure and Unit Headloss—the key starting parameters. I 

stick with the default rainbow scale. 

3. Adjust Map options to show node and link values, skipping IDs to reduce clutter. 

4. Hide arrows until the final stages to keep things clean. 

5. Use a black background to reduce eyestrain. If working on a white background, switch 

the yellow in the rainbow scale to pink or orange for better readability. 

BENCHMARKING 

If you have followed the recommended approach of gamifying your 

design, you should have a few fairly independent solutions. To benchmark 

them for cost, you will use the pipe costs as a proxy for total cost. Ideally, 

you would come up with a buried cost (pipe, transportation, and 

installation), but just the pipe cost will also work. Remember, we are not 

trying to produce an exact cost for the system, but rather figures that help 

compare options with each other. 

You will need a table like the one on the right. 

 

Exporting Pipes for Preliminary Costing 

1. To export pipe lengths click on the Table icon: 

 

 

 

2. Under the Type tab, select Network Links: 

 

 

 

 

 

3. In the Columns tab, select Length and Diameter and 

uncheck the rest of the options and click OK to close. 

 

 

ND (mm) Cost/m 

63 $2.36 

75 $3.35 

90 $4.82 

110 $7.19 

125 $9.14 

140 $11.50 

160 $15.03 

180 $19.05 

200 $23.50 

250 $36.51 



A Step-by-Step Manual for UNHCR and Partners   108 

 
4. Select all the cells:   

 

 

 

 

 

 

 

5. Go to Edit > Copy To… and select Clipboard and click OK in the box that opens. 

 

6. Open a spreadsheet such as Excel and paste. 

 

7. Select the numbers with the headers, then press on Ctrl + T to create a table: 

 

 

 

 

 

 

 

8. Click on the mm dropdown and sort the pipes by descending diameter: 

 

 

 

 

 

 

 

9. Total the lengths of each pipe size, multiply them by the pipe cost and find out the grand 

total. 
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10. Repeat for each design option 

Here is an example of benchmarking seven design options (Original, …, Pancake). Notice how, 

even on the second try, we’ve saved 28% compared to the original proposal! 

 

 

  Figure 43. Benchmarking exercise for seven design options (Source: S. Arnalich). 
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STEP 8. VALIDATING THE RESULTS 

 

Validating the results is both quick and essential. Understanding its importance can help resist 

pressures to deliver. 

There are mainly three pieces, we must make sure that: 

1. The DEM elevation risk is acceptable. 

2. The design is viable in the real world. 

3. The design files are error-free. 

REDUCING DEM ELEVATION RISK: EPADEM 

DEMs can speed up design, but design risks must be managed to ensure systems work within 

the DEM's error range. This is where EPADEM Risk Evaluator comes in. It’s a free tool that takes 

an EPANET file, creates multiple copies with node elevations randomly adjusted (based on a 

normal distribution), and runs simulations on each. It then calculates the percentage of designs 

that fail to meet minimum pressure criteria—that percentage represents the risk.  

The program is very simple to use as demonstrated in video 12.1 of the playlist. 

You can download it and its user manual here: 

https://arnalich.com/EPADEM.html 

 

 

 

 

 

 

 

 

 

 

GOAL:  Ensure the design is viable, error-free, and that risks are mitigated. 

 

Figure 44. Screenshot of the EPADEM Risk Evaluator. A total of 10,000 derived files from the 
original EPANET design were tested, achieving a 99% success rate. 

https://arnalich.com/EPADEM.html
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The user manual is a 10-minute read that provides simple and concise instructions on its use and 

interpretation.  

DO NOT use elevations from a DEM without managing risk—and not just any 

DEM will do. If you choose the speed and convenience of using DEM elevations, 

controlling for risk is essential. The good news is, it’s extremely easy to do! 

 

VIABILITY IN THE REAL WORLD 

Once the system layout is finalized, we must ensure its viability. Here are some key questions to 

consider:  

• Are there any physical obstacles to construction? Drawing over a satellite image is one 

thing, but in real-life,  there may be crossings, unstable ground, flood-prone areas, etc.  

• Can we secure land rights for water tanks and wells? 

• Can we obtain land permission to install pipes? 

• Does the design comply with local codes? 

• Are there potential conflicts with existing water rights or usage agreements? 

• What are the risks of theft, vandalism, or sabotage, and how will these be mitigated? 

• Is the design user-friendly for local operators with varying skill levels? 
 

DESIGN REVIEW CHECKLIST 

 

Short Design Validation checklist 

The following items have been described in the text and constitute the essential verifications on 

the high-level design: 

Population and demand 

 Camp population limit obtained from site planning. 

 Potential extension areas have been considered. 

 Water per capita allowance meets standards. 

Source 

 Source capacity is or can be developed to meet demand. 

Hydraulic design 

 Flow units set to LPS and Headloss Formula set to H-W. 

 Water flows in the correct direction. 

 Maximum pressure is below 80% of the pipe rating in all points. 

 Minimum pressure is above 10 m (7 m in a few points) 

 No closed pipes present in the model. 
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 Minimum diameter enforced, no pipes below 63 mm are installed for lengths longer 

than 50-100 m. 

 The model uses internal diameters, not nominal ones. 

 Roughness values match computation formula.  

 No default values present for length diameter, diameter, elevation, etc. 

 Demand loads are applied to the consumption points. 

 Pipe diameter does not increase downstream. 

 No typos in pipe diameters, elevations, etc. 

 Pipe runs as short as possible to most points. 

 At least 30% storage (of daily volume). 

 Pumps duty points are very close to their BEP. 

Materials 

 Use of PE100 HDPE pipe. 

 Use of at least PN10 pipe (10 bar) regardless of the pressure. 

Risk analysis 

 EPADEM Risk evaluator run on all EPANET files. 

 

EPANET Tools for Verification 

Flow Units and Headloss can be found at > Projects > Defaults > Hydraulics. 

To activate flow arrows right-click on the screen, select Options and Flow Arrows. 

Using Query 

Most of the remaining verifications concerning EPANET can be done using the Query button: 

 

 

 

For example, to check for closed pipes, use the dropdown menus and fields to make the phrase 

“Find Links with Flow Equal to 0” and click Submit. 

 

 

 

 

To query for minimum diameters we introduce “Find Links with Diameter Below 55”. Any pipes 

that match the condition will be highlighted in red: 
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To search for default values first you would have to know 

which ones have been used. Go to Projects > Defaults > 

Properties. You will then use Query to find pipes with diameter 

equal to 12, lengths equal to 1000, nodes with elevation equal 

to 0 and so on. 

 

 

 

 

For other verifications, i.e., diameters not increasing downstream, you can show them using 

the Browser: 

 

 

 

 

 

 

 

 

  

Figure 45. A query for diameters below 63 mm (55 mm ID) highlights one pipe in red. 

Figure 46. Using the Browser to verify pipe diameters. 
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STEP 9. ASSEMBLING A DESIGN DOSSIER 

 

At this point, excessive detail is the enemy. With every passing second, opportunity costs grow. 

A detailed report only adds to everyone’s workload and the users’ suffering with little to no 

benefit. It’s essential to keep things high-level. 

Aim for the 25/2500 Rule: 25 pages, 2500 words with images dominating rather than text. For 

reference, this manual has double the words per page.  

Working with a report template allows for a significant part of the report to be already written. 

You can find one in the book’s download file, EpaRef.zip. 

 

Share the Complete Dossier 

Nothing more frustrating than receiving a report with maps as images, topographic surveys in 

endless charts and EPANET simulations in screen captures all locked in a PDF file! For it to be 

useful, we need the complete dossier with all the native files, not just the narrative report.  

PROPOSED OUTLINE 

0. High-level Summary 

The Rapid Water Supply Planning concept 

1. Introduction 

1.1 Background 

1.2 Purpose 

2. Hydraulic Design 

2.1 Calculation Method 

2.2 Calculation Basis 

2.3 Hydraulic Design Criteria 

2.4 Population and Projections 

2.5 Elevation Risk Mitigation 

3. Proposed Design 

3.1 Equity of Access and Pressure Zones 

3.2 Emergency System 

3.3 Post-Emergency System 

4. Final Recommendations 

4.1 Next Steps 

4.2 Other Key Recommendations 

Annexes 

A.1 File Structure 

A.2 Pumping Mains Results 

A.3 Emergency System Results 

A.4 Post-Emergency System Results 

A.5 Pipe Routings with Site Plan 

GOAL:  Create a clear, concise, and straightforward report in the least possible time. 
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EXPORTING AND SHARING THE DESIGN FILES 

As mentioned, the design dossier should include the following files in addition to the report: 

 

 

 

 

 

 

 

1. Backdrop files. The EPANET BMP backdrop file and the Google Earth KMZ used to create 

it. 

 

2.  Pipe layout files. KMZ files are preferred over shapefiles or CAD files for the ease of 

access for devices and users.  

 

3. Excel files containing the pipe BoQ and the Initial Data used. 

 

4. EPANET files with the design. 

 

Resist the temptation to include unnecessary files. These four types are enough 

to detail what needs to be built, the pipe quantities, and the supporting data and 

calculations. Adding more only overwhelms the recipients, reduces clarity, and 

complicates sharing due to file size limits. 

 

We have already covered how to produce backdrops, create EPANET files and export a pipe BoQ 

(section 0). We will concentrate on producing KMZ with the pipe layout. 

EXPORTING PIPE LAYOUTS TO KMZ 

We will use a QGIS plugin to transform our EPANET layout to a Google Earth file that anyone can 

work with.  

1. In EPANET, make sure that you have set UTM coordinates in the dimensions in View >  

Dimensions: 
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2. Go to  File >  Export >  Network… to export the network as an INP file (EPANET input file). 

 

3. In QGIS, install the ImportEpanetInpFiles plugin. The process was described in step 12 of 

Exercise 9.3. 

 

4. In QGIS, go to  Plugins >  ImportEpanetInpFiles >  Import Epanet Input File. Navigate to 

the INP file you created in step 2. 

 

 

 

 

 

 

5. In the dialogue box that opens select the appropriate projection. In the Finder box type 

“UTM zone XXY” where XX stands for the zone and Y for N or S (North or South).  For 

example, if our coordinates are 34P 530000 1463000, then zone 34P is zone 34 in the 

northern hemisphere.  

 

We type UTM zone 34N in 

Filter, and then expand the 

sections under Predefined 

Coordinate Reference Systems 

below, by clicking the 

triangles for Projected and 

Universal Transverse 

Mercator. There, we will find 

a projection called WGS 84 / 

UTM Zone 34N and select it. 
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6. Click on the Export KMZ icon. If the icon is missing, ensure that you have installed the 

KML Tools plugin (refer to step 12 of Exercise 9.3). 

 

 

 

 

 

 

7. Select the layer containing the pipes as the Input layer (1). Select diameter as 

Name/label field (2). 

 

 

 

 

 

 

8. Scroll down to Output KMZ file, click on the three dots, select Save to a file and choose 

a file name and destination folder. Click Run. 

 

 

 

 

 

 

9. Open the KMZ file to see the results and check that the pipes are where they should be. 

You can adjust the appearance in Google Earth and remove the decimal places by editing 

the labels in QGIS. 
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Figure 47. Pipes exported as KML in Google Earth, a simple way to communicate without specialized software.. 

 

Always include clear screen captures of all pipe layouts in your report. If the 

report is separated from the files, these visuals will serve as a valuable reference. 
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